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Request Management Introduction
Request Management is an integral component of the ServiceCenter system. 
It provides automated ordering, manager approval, and tracking of assets 
through the different phases of their life cycles, from requesting, ordering 
and procurement to delivery and installation.

Read these chapters for information about Request Management.

� Request Management Overview on page 13

� Security and Access on page 29

� Catalog Operations on page 61

� Approvals on page 123

� Alerts, Events, and Messages on page 143

� Ordering on page 171

� Closing and Receiving on page 185

� Request Management Event Services on page 195

See these appendices for explanations about some Request Management 
processes and terms.

� Pre-Implementation Planning on page 211

� Link Records on page 221

� Macros on page 223

� Glossary on page 225
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Knowledge Requirements

The instructions in this guide assume a working knowledge of Peregrine 
Systems ServiceCenter and the installation platform. You can find more 
information in the following guides.

� For information about a particular platform, see the appropriate platform 
documentation.

� For information about customizing your environment using parameters, 
see the ServiceCenter Technical Reference guide. 

� Before you run the ServiceCenter server, see the ServiceCenter User’s 
Guide.

� For administration and configuration information, see the ServiceCenter 
System Administrator’s Guide or the ServiceCenter Application 
Administration Guide.

� For database configuration information, see the ServiceCenter Database 
Management and Administration Guide.

� For copies of the guides, download PDF versions from the CenterPoint 
web site using the Adobe Acrobat Reader, which is also available on the 
CenterPoint Web Site. For more information, see Peregrine’s CenterPoint 
Web Site You can also order printed copies of the documentation through 
your Peregrine Systems sales representative.

Examples 

The sample windows and the examples included in this guide are for 
illustration only, and may differ from those at your site. 

Contacting Customer Support

For more information and help with this new release or with ServiceCenter 
in general, contact Peregrine Systems’ Customer Support.

Peregrine’s CenterPoint Web Site
You can also find information about version compatibility, hardware and 
software requirements, and other configuration issues at Peregrine’s 
Centerpoint web site: http://support.peregrine.com
10 � Request Management Introduction 
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1 Log in with your login ID and password. 

2 Select Go for CenterPoint.

3 Select ServiceCenter from My Products at the top of the page for 
configuration and compatibility information.

Note: For information about local support offices, select Whom Do I Call? 
from Contents on the left side of the page to display the Peregrine 
Worldwide Contact Information.

Corporate Headquarters

North America and South America

Europe, Asia/Pacific, Africa
For information about local offices, see Peregrine’s CenterPoint Web Site on 
page 10. You can also contact Corporate Headquarters.

Address: Peregrine Systems, Inc.
Attn: Customer Support
3611 Valley Centre Drive
San Diego, CA 92130

Telephone: +1 (858) 794-7428

Fax: +1 (858) 480-3928

Telephone: +1 (800) 960-9998 (US and Canada only, toll free)

+1 (858) 794-7428 (Mexico, Central America, and 
 South America)

Fax: +1 (858) 480-3928

E-mail: support@peregrine.com
Contacting Customer Support � 11
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Contacting Education Services

Training services are available for the full spectrum of Peregrine Products 
including ServiceCenter. 

Current details of our training services are available through the following 
main contacts or at: 

http://www.peregrine.com/education 

Address: Peregrine Systems, Inc.
Attn: Education Services
3611 Valley Centre Drive
San Diego, CA 92130

Telephone: +1 (858) 794-5009

Fax: +1 (858) 480-3928
12 � Request Management Introduction 
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CHAPTER

1
 Request Management Overview
ServiceCenter’s process flow when ordering items and services includes 
out-of-box catalog choices, making it possible for you to order bundled items 
and services. You do not have to wait to order line items after the quote has 
been opened, but you can do it all up front. You also have the option to add 
more line items to your order later, if needed.

If you find yourself asking when you should use Request Management versus 
Change Management, here are some guidelines.

� Request Management is designed to handle common user requests for 
products and services. These requests will usually only affect the person 
making the request, or a small group of people for which the requestor is 
responsible.

� Change Management is designed to handle any change to your business 
environment that will modify or disrupt the current state of that 
environment. Usually these modifications, or disruptions, will affect 
multiple users or business units.

Key Request Management features include:

� Automated request, manager approval, and order processing tracking for 
products and services.

� Detailed, customizable catalog of products and services, including 
bundled and sequenced parts and services.

� Scheduling and integration of service requests and work orders with 
purchase requests.
Request Management Overview � 13
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� Combination of multiple quotes into single or multiple orders, based on 
vendor.

� Provision for external vendors and internal work groups.

� Integration with other ServiceCenter applications, such as Inventory 
Management and Change Management.

� Integration with other Peregrine Systems products, such as Asset Center 
and Facility Center.

� Sequential and Conditional on-line request entry and approvals.

� Automated Mail Notification and Alerts for normal and exceptional 
events.

� Customer Control and consolidation of acquisitions and lifecycle 
management.

� Request—>Order—>Receiving—>Posting process.

The front-end and most often encountered component of Request 
Management is the catalog. The catalog contains lists of items that are 
available for request, as well as bundled Request Categories, which include 
Customer Procurement Requests, Human Resources, and Employee Office 
Move with their components and lists of item types.

The Master Catalog allows the user to select a predefined set of hardware, 
software, and services, which constitute an item. This item, in turn, is 
available for order through the catalog and all associated components are 
included in the order. For example, the New Employee Setup item within the 
Human Resources category includes associated components, such as office 
furniture, CPU with monitor and mouse, and network connectivity. The 
user orders the one item, New Employee Setup, then orders for all the 
components of the ordered item are sent out. Each component is then 
tracked as the order is processed, the product is received, and the product is 
installed or delivered to the user’s site.

Many features of the Request Management application are available to the 
administrator (FALCON) login only. The following sections include 
instructions for using Request Management when logged in as FALCON, 
SUSIE.SUPERTECH, or MAX.MANAGER.
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Process Flow

Figure 1-1 shows the workflow for Request Management.

Figure 1-1: Request Management Process flow

Close
Quote Quote

Admin
Approval YesNo

User
Approval

Order Complete

Item Received
(service or product)

Line Items

Order
(by line item)

Catalog

YesNo
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Sample Operation

Your access to Request Management features will vary, depending on how 
you have logged in. For example, while FALCON has access to opening 
orders, approving quotes, and processing orders, the SUSIE.SUPERTECH 
login will only allow you to update work orders assigned to you.

Opening a Quote
To open a quote (using FALCON login):

1 From the system administrator’s home menu, select Request Management. 
Figure 1-2 shows the Request Management main menu. 

Figure 1-2: Request Management main menu
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2 From the Request Management main menu, click Open New Quote. 
Figure 1-3 shows a QBE list of master categories. Select a master category 
from the list. For this example, select Customer Procurement Requests.

Figure 1-3: QBE List of master categories

3 Figure 1-4 shows a group of further subdivided line item categories.

Figure 1-4: Line item categories within a master category
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ServiceCenter
4 Your selections within the Master Catalog help you to specify the type of item 
you are requesting. For example, when you double-click Computers & 
Related, ServiceCenter displays a QBE itemized list of computer and related 
items, as shown in Figure 1-5.

.

Figure 1-5: QBE list of computer and related items
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5 Select the item you would like to order. For this example, select Individual 
Monitors. As you can see, the categories continue to partition into smaller 
itemized lists. For this example, Figure 1-6 shows a list of available parts that 
are various sizes of monitors.

Figure 1-6: Selecting an item type from the QBE list

6 For this example, we will select the needed part. Select the 17” monitor, 
professional series. Figure 1-7 on page 20 shows the Request Management 
confirmation screen that enables you to:

� Cancel your order

� Add more items to your order

� Submit your final request to order items
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Figure 1-7 shows a request for an order.

Figure 1-7: Submitting a request for order

1 Select Submit Request to submit your request.
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2 Figure 1-8 shows the form where you can supply information specific to 
placing the quote, including, user name, department, and telephone number. 

Figure 1-8: New Quote Form

3 Do one of the following:

� If you have the information, enter it in the appropriate fields and click OK.

� Click Fill in the Requested for field to access the search dialog box and 
open a QBE list of available contacts.

To search for a contact name:

� Do one of the following:

� Position the cursor in the Contact Name field and enter the name or 
portion of the name of the contact record you want to locate. Press Enter 
or click Search.
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� Leave the fields blank and click Search to perform a true query and retrieve 
a list of current contact records. Figure 1-9 shows the QBE list of contacts. 
Double-click the contact who is placing the request. 

Figure 1-9: QBE List of Contacts

Note: If this contact is associated with more than one device, a second QBE 
list is displayed.

The initial quote screen redisplays with the contact information populated.

4 Continue filling in other information, such as required delivery date and 
reason for request.

5 When you have filled in the contact information, click OK to submit the 
quote. Figure 1-10 on page 23 shows the Request Management Summary 
form with order information. Notice the status bar at the bottom of the 
screen indicates that this order is in the approval phase. Other pieces of 
information you can view in this summary are:

� detailed contact information

� bundled items requested

� total line items of order(s)

� current approvals and Approval log
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� information about the person who requested the order

� related incidents, changes, or calls

Figure 1-10: Request Management Summary screen

6 When you are finished, click Save to save the record or click OK to save the 
record and return to the Request Management main menu. 
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Request Management Options

The options and list options differ slightly between new forms and existing 
forms.

Options Menu
When you are opening a new or existing quote, the Options menu contains 
the following options.

Option Description

Print Prints the current record to the default printer.

Audit History Enables revision tracking.

Database Manager Opens the Database Manager, which accesses 
records from any of ServiceCenter’s files.

Search Duplicates Queries the Request Management database for 
duplicate orders. The search is based on the data 
entered in the current form.

Validity Lookup Checks the selected field against the ServiceCenter 
validity tables for that field.

Related

Related|Incidents|Open Allows you to open the associated Incident ticket. 
For more information, see Related Records on 
page 26.

Related|Incidents|Associate Allows you to associate this quote to an Incident 
ticket. For more information, see Related Records on 
page 26.

Related|Incidents |View Allows you to view the associated Incident ticket. 
For more information, see Related Records on 
page 26.

Related|Calls|Associate Allows you to associate this quote to a call. For more 
information, see Related Records on page 26.

Related|Calls|View Allows you to view the associated call. For more 
information, see Related Records on page 26.

Related|Changes|Associate Allows you to associate this quote to a Change 
Request. For more information, see Related Records 
on page 26.
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Related|Changes|View Allows you view the associated Change Request. For 
more information, see Related Records on page 26.

Line Items View individual records for line items in a quote.

New Line Item Add a new line item to the existing quote.

View Actual Order Lines View line items of an order in the Bundled view to 
see details about the order, including line item 
number, description, quantity, and cost.

Change Category Allows you to change the category of the quote.

Change Phase Allows you to change the phase of the current order.

Logs

Logs|Phase Log Lists quotes and their current phase.

Logs|Alert Log Lists quotes and their alert status.

Logs|Approval Log Lists approval actions.

Current Alerts Lists currently scheduled and active alerts.

Approval > Approve | Deny When your login is part of an approval group, this 
option allows you to approve, deny, or you can 
retract a quote that you created.

List Pages Allows you to list all the pages associated with this 
quote.

Calculate Impact Allows you to calculate the risk of this quote or order 
against records with defined weighted values.

Copy and Open Allows you to copy a single line item or multiple line 
items of an existing quote to open a new quote.

Expand Array Add a field to an array (list of elements of the same 
data type accessed by an index or element number). 
A separate window is displayed to enter the data.

Generate Maintenance The Database Manager utility enables you to 
manipulate tasks for this record. Database Manager 
is covered in the ServiceCenter System Tailoring 
Guide.

Option Description
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List Options Menu
When you are updating an existing Request Management quote, the List 
Options menu contains the following list options.

Related Records
The Options menu allows you to create an association between existing 
records, view a list of associated records, and open new records. The Request 
Management Options menu allows you to work with incidents, changes, and 
calls.

Opening a Related Record
You can open a Change Management change or an Incident Management 
incident ticket from Request Management. The new record will be related to 
an existing quote. For this example, we’ll open an Incident Management 
incident ticket.

To open a related record from Request Management:

1 Display an existing Request Management quote.

2 Open the Options menu and highlight Related|Incidents.

3 Click Open.

The Incident Select Category form will display. Select a category and fill out 
the form. Refer to the appropriate chapters (Service Management, Incident 
Management, and Change Management) in the ServiceCenter User’s Guide 
for help in filling out the form.

List Option Description

Count Counts the records displayed in a record or QBE list. The total 
is displayed in the status bar at the bottom of the window.

Print Records Allows you to print all the information within a record, 
including the updates.

Print List Allows you to print a record, multiple records, or a QBE list.

Refresh Refreshes the record or QBE list display.

Modify Columns Allows you to edit column headings in a record or QBE list. 
For more information, see the ServiceCenter User’s Guide.

Save as Inbox Allows you to save the current list as an inbox.
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4 Save the related record. Click Qopen. You will be returned to the initial 
Request Management quote.

Associating a Quote with Another Record

You can associate a Request Management quote with an existing Service 
Management call report, an Incident Management incident ticket, or Change 
Management change. Before associating a quote with another record, make 
note of the record’s ID number. For example, a call report could have an ID 
number of CALL1001. You will need to enter this number during the 
following process. 

In the following example, we will associate a Request Management quote 
with a call report. The procedure is the same for associating other types of 
records.

To associate a quote with another record:

1 Access a Request Management quote.

2 Open the Options menu and highlight Related|Calls.

3 Click Associate.

4 A dialog box will is displayed, asking: 

Associate Quote Qxxxx with which Call?

5 Type the ID number. 

� For a call report, type the number in the form of CALLxx, where xx is the 
call number.

� For an incident, type the number in the form of IMxx, where xx is the 
incident number.

� For a change record, type the number in the form of xx. The change 
number does not have a defining letter.

6 Click OK. A confirmation message is displayed in the status bar.

Viewing Associated Records
You can view and edit associated Incident Management incident tickets, 
Service Management calls, and Change Management change tickets from a 
Request Management quote.
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In the following example, we will view an incident ticket associated with a 
Request Management quote. The procedure is the same for viewing other 
types of records.

To view an associated record:

1 Access a Request Management quote.

2 Open the Options menu and highlight Related|Incident.

3 Click View. A list of related Incidents is displayed.

4 Double-click on an Incident to view the details. The ticket will open. You can 
edit the Incident ticket from here, including Resolving the ticket.

Viewing a Quote
To view an existing quote (MAX.MANAGER login):

1 Click Request Management on the main menu. Figure 1-11 shows the 
Request Management Menu for MAX.MANAGER.

Figure 1-11: Request Management Main Menu—MAX.MANAGER
28 �Chapter 1—Request Management Overview 



CHAPTER

2
 Security and Access
Security in the Request Management process is essential. Most operators will 
only need access to limited areas and items for requesting and ordering. In 
the same light, only certain operators should be allowed to approve requests 
and orders, mark shipments as received, and respond to operators requesting 
items. These subtle aspects of distinction are possible within Request 
Management.

This chapter addresses the various security access issues in Request 
Management, including:

� Overview on page 30

� Capability Words on page 30

� Request Management Environment on page 32

� User Profile on page 37

� Group Records on page 57
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Overview

Request Management uses several files containing records on individual 
operators to secure the database and provide efficient use of request 
functional areas (quotes, orders, and line items), including:

Note: If there is a conflict in the settings for a particular operator, the User 
Profile record settings override the environment settings in Request 
Management. Then the category and phase record settings for the 
functional areas override the User Profile record settings. Ultimately, 
those restrictions established in the category and phase definition 
records determine operator access privileges.

Capability Words

Every ServiceCenter operator has an operator record, which contains an 
array (list) of words defining the capability (access privileges) of the operator. 
In order for operators to access Request Management, those operators must 
have at least one of the following capability words defined in their operator 
records:

� OCMAdmin (Request Management Administrative access)

� OCML (Request Management Line-Item processing access)

� OCMO (Request Management Order processing access)

� OCMQ (Request Management Quote/Request processing access)

� SysAdmin (System Administrator access to everything)

To display capability words:

1 Select the Utilities tab from the system administrator ServiceCenter menu.

2 Click Administration.

3 Click Capability Words in the Security structure. A blank Capability File 
form (capability) is displayed.

4 Do one of the following:

� Enter a Capability Word to pull up a Capability record.

� Click Search to pass a true query without entering any values in the form. 
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Figure 2-1 shows a record list of all current Capability Word records.

Figure 2-1: Displaying capability words

To add one of the required capability words to each operator who is to have 
access to Request Management in one way or another:

1 Select the Utilities tab from the system administrator ServiceCenter menu.

2 Click Administration.

3 Click Operators in the Security structure.

4 Do one of the following:

� Select the login name of the operator to bring up the operator record.

� If you do not know the login name, click Search to perform a true query 
without entering any values in the blank operator form. A record list with 
the requested login names is displayed. Make your selection by clicking on 
a login name.

5 Select the Startup tab from the Operator Record menu.
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6 In the Execute Capabilities field, enter the appropriate capability word for 
Request Management access, as shown in Figure 2-2.

Figure 2-2: Modifying privileges through Capability Words

See the ServiceCenter System Administrator’s Guide for details about 
capability words.

7 Click Save to record the changes.

Request Management Environment

Within Request Management, environment records define the overall 
operating environment for the area, and establish the various features within 
each functional area— quotes, line items, and orders. The environment 
records contain information specific to each operator, including access 
rights, numbering format and length, and enabled/disabled alerts and events. 
Environment records are required in order to access a particular functional 
area within Request Management.
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Environment Access

Viewing Environment Records
To view the Quotes, Line Items, and Orders environment records:

1 Signed on as a system administrator, select Request Management from the 
system administrator’s home menu.

2 Select Environment on the Quotes, Line Items, or Orders tab of the main 
Request Management menu. The environment record is displayed, 
environment.ocmq, environment.ocml and environment.ocmo respectively. 
These forms contain mostly the same fields, though different values may be 
entered for each, as they control separate functional areas.

Figure 2-3: Line Item Environment Settings

Use the following definitions to determine the values for the form fields.
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Quote Options Structure

These determine the overall behavior of quotes and how they will be 
processed.

Number Controls Structure

Each of the first three options below retrieves the unique sequential number 
according to the ocmq, ocmo, and ocml records in the number file. The 
number.reset application can be used to reset this unique number at the 
beginning of each year, or more often if necessary. These number controls 
determine how your quotes will be numbered.

Option Description

Allow Access? If true, operators without user profiles can access the area 
using the area’s default profile.

Schedule Alerts? Allows alerts to be turned on (true) or off (false) for the entire 
area, such as alerts added to the current alerts file, or not.

Schedule Events? Allows event processing to be turned on (true) or off (false) 
for the entire area, such as events added to the schedule file, or 
not. Default is false.

Operator ID/Full 
Name

Controls if the Operator’s Login ID or the Full Name is 
recorded in the application’s records. If true, the Operator ID 
is recorded; if false, the Full Name is recorded. The default is 
false. This information is recorded in the variable 
ocm.ufname.

Option Description

Yr/Unique No 
(YYNNN)

The current year (system-calculated), followed by a 
unique sequential number.

Yr-Mo/Unique No 
(YYMMNNN)

The current year and current month (system-calculated), 
followed by a unique sequential number.

Julian/Unique No 
(YYDDDNNN)

The current Julian date (system-calculated), followed by a 
unique sequential number.
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Stockroom Option Structure

When a line item has been completely received, it should be:

Editing Environment Records

To edit any of the Request Management environment records:

1 Open Request Management from the main ServiceCenter menu.

2 Click Environment on the appropriate tab (Quotes, Line Items, or Orders).

3 Use the field definitions described in Viewing Environment Records on 
page 33 to determine the exact restrictions or permissions you wish to enable 
for your operators.

Unique Number Only A unique number without prefixes or suffixes, retrieved 
from the number file (ocmq, ocml or ocmo classes).

� Separator—use a separator character between your 
main quote or order number and the included line 
items/parts, such as, 
Q1234-001.

� Unique Number Length—set the length of the unique 
number to be added (this will determine how often you 
may need to reset your numbers).

Parent No/Unique No 
(PPPNNN)

The Parent Quote or Order number, followed by a 
sequential number determined by the total.line.items field 
in the parent item. This option is only displayed in the line 
item environment record (environment.ocml).

Option Description

Marked as “In Stock” Item should be marked as In Stock.

Closed Item should be marked as Closed.

Option Description

Sort Master Categories 
By

When selecting items from the catalog, the master Line 
Item categories can be sorted on any field in the 
ocmcatselect database.

Sort Line Item 
Categories By

When selecting Line Item categories, sort by these fields in 
the ocmlcat database.

Option Description
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4 Determine the numbering format to establish for quotes, line items, and 
orders.

5 Decide on a separator character between your main quote or order number 
and the included line items/parts, such as Q1234-001 and O2345-100.

6 Determine the length of the unique number to be added (this will determine 
how often you may need to reset your numbers).

7 Click Save to record the new environment record.

Number Reset Application
Resetting the number file at a particular point may be required due to heavy 
activity, auditing requirements, dates being used as part of the numbering 
convention, or several other scenarios. Number resetting is often performed 
on a monthly or annual basis, depending on your numbering scheme for that 
functional area.

The number.reset application can be used to force the number file to be reset 
at a particular time. The application resets the number record to zero (0).

Important: Quote and Order line item numbers are stored in the same file, 
Line Items file (ocml), distinguished by default with Q for quotes 
and O for orders. When resetting numbering, you need to take 
into account whether future records will conflict with current 
record numbers. The number must be a unique value, as defined 
in the database dictionary file for each of the ocm files.

A schedule record must be defined to run in any ServiceCenter background 
processor. This record should be set to execute the number.reset application.

To reset the number.reset application:

� Access the environment record, as described in Environment Access on 
page 33. 

To reset the number controls:

� Refer to Number Controls Structure on page 34 for detailed information 
about the fields within the Number Controls structure.
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User Profile

The user profile controls the Request Management function access for users. 
Users can have the assigned User Role’s standard profile, or be assigned to a 
unique profile to establish user access.

Further specifications are achieved through a separate profile for each of the 
three functional areas of Request Management, or one profile can be used for 
access to all. If two profiles are built for an operator, such as one for the Quote 
area and another for All areas, the profile with the specific area option takes 
precedence and overrides the All areas profile.

Viewing a User Profile
1 Open Request Management from the main ServiceCenter menu.

2 Click Supporting Files on the Maintenance tab.

3 Click Profiles in the Support structure.

A blank operator profile form (ocmprofile) is displayed.
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4 Click Search to pass a true query without entering any values in the form. 
Figure 2-4 shows a record list of all current user profiles.

Figure 2-4: Operator Profile Record

A list of available user profiles appears above the data from the first record.

5 Select a profile to view from the list by clicking on the name. The selected 
record is displayed.
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The profile form (ocmprofile) displays the specific access rights available to 
the user.

The tabs below the identification information include profile control 
options, which are specific to the operator or group. The default condition 
for the check boxes on these tabs for all operators is set to unknown, which 
equates to false for all operators except those with SysAdmin or OCMAdmin 
authority, then the default is true.

Note: On the tabs, red field items are confirmation controls and the other 
field items are display/Format Controls, which display in the Options 
menu or as buttons in the system tray.

If you need to make changes to the ocmprofile.g form profile controls and 
options, use Forms Designer. The “Input” properties (security field names) 
for the controls/options described in the tables below are included as well. 
See the ServiceCenter System Tailoring Guide to become familiar with using 
Forms Designer.

Profile Option Description

Profile Name
(required)

Identifies the operator login ID for which this profile 
applies.

Manager Group Identifies the manager group to which this 
operator/group belongs. This information is provided for 
routing approvals for any records this operator/group 
opens.

Member Groups Identifies which Request Management operator groups 
with which this operator/group belongs. These groups and 
their rights are explained in the following section.

Area Identifies to which functional areas this profile applies, 
such as, Quotes, Order, Line Items, or All.

Require Password States whether this operator must provide a password in 
order to access the given area of Request Management 
(true=yes. false=no).

Approval Groups Identifies the Request Management Approval groups to 
which this operator/group belongs; for setting security 
and approval functions. Approval groups have control 
over the movement of items from one phase to another. 
For more information, see Approvals on page 123.
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Basic tab profile options
This tab has general restrictions to functionality like Find, Fill, Open, 
Reopen, Save and View options. See the Basic tab shown in Figure 2-4 on 
page 38.

User Profile Controls and Options are stored in the $G.ocmx.environment 
variable (orders = ocmq.quotes, orders = ocmo.orders, lines = ocml.lines). Each 
option can be accessed by its Security field name, shown in the first column 
of the control/profile the following option tables. 

For example: To access the controls/options for evaluating the condition 
when the system displays the standard SC confirmation open prompt, access 
the cfrm.open security field in the $G.ocmq.environment (cfrm.open in 
$G.ocmq environment).

See the following table for detailed descriptions of the Profile controls and 
options.

Control/Option
(Security Field 
Name) Description

When Available
Availability Conditions

All Functions

(all)

Sets all OCM function conditions 
to true.

Audit History

(audit)

Controls access to the Audit 
History database. If auditing is not 
used in your OCM system, this 
option should be set to false. 

Displayed while viewing 
Quotes/Orders/Line 
Items.

Calculate Impact

(calcrsk)

Accesses standard Validity Tables 
and calculates the Risk for the 
current record. This calculation is 
based on the same logic used in 
CM3 to determine Risk.

Available while viewing a 
Quote/Order/Line Item.

Close

(close)

Closes the currently displayed 
record by updating the status of the 
open field to false, executes the 
close.script (as per the Phase or 
Category definition), and closes the 
record. 

Displayed while viewing 
Quotes/Orders/Line 
Items.

close, Locked, Phase 
Close Cond=true, 
open~=false

Change Category

(new.category)

Opens a new category.
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Change Phase

(new.phase)

Opens a new phase.

Conf Close

(cfrm.closed)

When the condition evaluates to 
true, the system displays the 
standard SC confirmation prompt 
when the operator selects the close 
option.

After initiating the close 
option.

Conf Copy & 
Open

(cfrm.copy)

This condition is evaluated after the 
operator starts the copy&open 
process. If it evaluates to true, the 
system displays the standard SC 
confirmation prompt to confirm 
the copy&open action.

After initiating the 
copy&open option.

Conf End

(cfrm.end)

When the condition evaluates to 
true, the system displays the 
standard SC confirmation prompt 
when the operator selects the end 
option. 

After initiating the end 
option.

Conf Open

(cfrm.open)

When the condition evaluates to 
true, the system displays the 
standard SC confirmation prompt 
when the operator selects the open 
option.

After starting the Open 
process.

Conf Next Phase

(cfrm.nextphase)

When the condition evaluates to 
true, the system displays the 
standard SC confirmation prompt 
when the second or higher Phase of 
an item is started.

After starting the next 
Phase of a Quote/Order.

Conf Print

(cfrm.print)

When the condition evaluates to 
true, the system displays a 
confirmation prompt when the 
operator attempts to print the 
currently open record.

After initiating a print 
operation on the current 
record.

Conf Reopen

(cfrm.reopen)

When the condition evaluates to 
true, the system displays a 
confirmation prompt when the 
operator selects the reopen option

After initiating the 
reopen process.

Control/Option
(Security Field 
Name) Description

When Available
Availability Conditions
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Conf Update

(cfrm.update)

When the condition evaluates to 
true, the system displays the 
standard SC confirmation prompt 
when the operator selects the 
update option.

After initiating the 
update process.

Copy & Open

(cpyopn)

Copies the data from the currently 
displayed record to a new record 
and attempts to open it. Note that 
the data from the currently 
displayed record must meet all 
standard Format Control and 
Validity Table processing for the 
open process. The Alerts and 
Approvals from the currently 
displayed record are not copied. 
New Alerts and Approvals are built 
for the new record.

While viewing records.

Count

(count)

Counts the number of records in 
the current qbe list

While viewing a qbe list.

Database 
Manager

(database)

Allows access to the native Database 
Manager prompt. From this point, 
the operator can access any 
ServiceCenter file (assuming access 
is granted by ServiceCenter 
security). 

Displayed while viewing 
a Quote/Order/Line 
Item.

Expand Array

(expand)

Expands the current array by 
executing the standard edit.array 
application

Available on all standard 
OCM RIO panels.

Fill 

(fill)

Executes standard ServiceCenter fill 
processing.

Available on most OCM 
RIO panels. 

While viewing records: 
fill, locked, evaluate 
(update) (the operator 
must have update 
authority).

All other times:

fill

Find

(find)

Executes standard ServiceCenter 
find processing.

Available on most OCM 
RIO panels.

Control/Option
(Security Field 
Name) Description

When Available
Availability Conditions
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Generate Orders

(generate.order)

Overrides the standard Order 
Generation Process and 
immediately opens an Order for all 
Line Items of a Quote.

Available only while 
viewing Quotes.

generate.order, locked, 
Phase Generate Order 
Cond=true

Line Items

(access.li)

Finds all Line Items associated with 
the currently displayed 
Quote/Order. If no Line Items are 
found, the Line Item open process 
is automatically invoked.

Available while viewing a 
Quote/Order.

List Pages

(pagelist)

List all the pages associated with this 
quote.

Mark/Drop 
Available

(avail.to.order)

This option controls two functions 
that toggle between each other 
based on the status of the 
avail.to.order field.

mark avail: Allows the operator to 
manually mark the first level of 
associated Line Items as being 
available for Ordering. This starts 
the Order generation process for a 
Quote’s Line Items. 

drop avail: Sets the avail.to.order 
flag to false. In other words, the 
Quote Line Item is no longer 
available for Order processing

Displayed while viewing 
a Quote Line Item.

mark avail:avail.to.order, 
null(parent.line.item in 
$L.file) (the Line Item is 
not consolidated with 
other Line Items), 
avail.to.order =false (the 
current Line Item is not 
marked for Ordering)

drop avail: 
avail.to.order=true (the 
current Line Item is 
marked ready for 
Ordering)

Open

(open)

Takes the data entered by the 
Operator, executes the appropriate 
Scripts (defined in the Phase or 
Category records) and adds it to the 
appropriate database with a status 
of open (the open field is set to 
true). 

open: Available on the 
initial query screen.

open

open new: Available 
while viewing an existing 
Line Item.

open, 

ACTION=“receive” (the 
receiving action is not 
currently active), Phase 
Add Line Item Cond (of 
the Parent Quote)=true

Control/Option
(Security Field 
Name) Description

When Available
Availability Conditions
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Phase Log

(phase.log)

Accesses the ocmphaselog records 
for the current Quote/Order via 
standard Database Manager

Available while viewing a 
Quote/Order.

phase.log, locked

Post

(post)

Takes the quantities displayed and 
posts them to the indicated Quote 
Line Items.

Displayed during the 
receiving process

Receive

(receive)

Begins the receiving process for the 
currently displayed Line Item. This 
option is available for Line Items 
only. 

Available while viewing 
Orders and Line Items.

For Orders: receive, 
locked

For Line Items:

receive, parent locked, 
not null(parent.order in 
$L.file) (the Line Item is 
subordinate to an Order)

Reopen

(reopen)

Executes the Reopen Script 
(defined in the Phase or Category 
record) and updates the record to a 
status of open (i.e., the open field is 
true). 

Available while viewing a 
closed record.

reopen, locked, 
open=false, Phase 
Reopen Cond=true

Save

(update)

Grants update authority to records. 

update, locked, 
open=false, Phase 
Update Cond=true

(Closed) Save Grants update authority to closed 
records. 

Available while viewing 
closed records.

Search Duplicates

(duplicates)

Searches for duplicate orders.

Select

(select.components
)

Begins the process of selecting a 
Part for a Line Item where part 
selection was deferred by the 
operator when it was selected from 
the Catalog.

Available while viewing a 
Line Item whose part 
selection was deferred.

select.components, 
locked, 
evaluate(defer.selection 
in $L.file) (part selection 
was previously deferred)

Control/Option
(Security Field 
Name) Description

When Available
Availability Conditions
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Show Scripts

(scripts)

Opens a window showing all Scripts 
that may be executed from the 
currently displayed record. 

Available while viewing a 
record.

scripts, locked

Split

(split)

Begins the process of splitting the 
current Line Item.

Available while viewing a 
Line Item.

split, locked

Show Subtotals

(subtotal)

Invokes the Subtotal process that is 
associated with the file of the 
current area

Available while viewing a 
record.

subtotal, locked, 
open=true or unknown

Validity Lookup

(valid.lkup)

Allows access to standard Validity 
Table Look-up processing. 

While viewing a record.

Views

(views)

Allows the operator to select an 
alternate format for viewing the 
currently displayed record of QBE 
format. After the new format is 
selected, its display Format Control 
is executed (this does not apply to 
QBE formats)

While viewing a record 
or a QBE list of records.

views (while viewing a 
record)

views and 
lng(denull(qbeformats 
in ocmxfcm))>0 (there is 
at least one QBE format 
defined in the master 
Format Control record)

Control/Option
(Security Field 
Name) Description

When Available
Availability Conditions
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Alert/Approval tab profile options
Determine this operator/group’s rights for manipulating alerts and issuing 
approvals of different items. 

Figure 2-5: User Profile - Alert/Approval tab

Control/Option
(Security Field 
Name) Description

When Available
Availability Condition

Alert Options

Add

(alert.add)

Controls the standard database 
manager add option when the 
current alerts log is accessed from a 
Quote/Order. 

During the process of 
finding the Alerts 
associated with the 
current record. Displayed 
when no records currently 
exist.

Alert Log

(alert.brw)

Allows the operator to access the 
current alerts log while viewing a 
record. If the record is locked, you 
will have update authority against 
the log records. If the record is not 
locked you will not have update 
authority against the log records.

Displayed while viewing a 
Quote/Order/Line Item.

Approval Action

(appr.active)

Displays the approval 
requirements currently pending 
the approval of the current 
operator.

Displayed while viewing a 
Quote/Order.
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Approval Log

(approve.brw)

Displays all approval logs 
associated with the currently 
displayed record. If this option is 
selected while viewing a 
Quote/Order then the approval 
logs generated by both the 
Quote/Order and the associated 
Line Items are displayed. If this 
option is selected while viewing a 
Line Item, then only the approval 
logs generated by the Line Item are 
displayed

Displayed while viewing a 
Quote/Order/Line Item.

Approvals

(approvals)

Begins the process of finding all 
Quote/Orders that are currently 
pending the approval of the 
current operator.

Displayed on the 
Quote/Order initial query 
screen.

Approve

(approve)

Updates the approval.status of the 
current approval log to approved. 

Displayed when viewing 
one approval log record.

approve, 
status=“pending” or 
“future” or “approved”, 
locked, Phase Approval 
Cond=true, gcond=true 
(The operator must have 
approval authority for the 
current group or must 
have override authority)

Deny

(deny)

Updates the approval.status of the 
current ocmapprlog to denied. 

Displayed when one 
approval log record is 
displayed.

deny, (status=“pending”, 
“future” or “approved”), 
locked, Phase Approval 
Cond=true, gcond=true 
(the operator must have 
approval authority for the 
current group or must 
have override authority)

Control/Option
(Security Field 
Name) Description

When Available
Availability Condition
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Retract

(retract)

Removes the previous approval or 
denial action taken against a given 
approval log and resets the status 
to pending. 

NOTE: This parameter also 
controls the retract all option. The 
retract all will retract all records in 
an approval requirements list.

Displayed when one 
approval log record is 
displayed.

deny, (status=“approved" 
or “denied”), locked, 
Phase Approval 
Cond=true, gcond=true 
(the operator must have 
approval authority for the 
current group or must 
have override authority).

Override

(approve.override)

When this condition evaluates to 
true, the normal group restrictions 
that apply to the approval process 
(i.e., an operator must be a 
member of the group in order to 
approve, deny or retract for that 
group) are ignored. 

While viewing an 
ocmapprlog record.

Control/Option
(Security Field 
Name) Description

When Available
Availability Condition
48 �Chapter 2—Security and Access 



Request Management Guide
Print/Query tab profile options
Determine how background, foreground printing of the operator/group 
members can print and what query restrictions (such as partial key and 
advanced) apply.

Figure 2-6: User Profile - Print/Query tab

Control/Option
(Security Field 
Name) Description

When Available
Availability 
Conditions

Print Options

Background

(print.bg)

Allows the operator to schedule 
print requests in the report 
background processor

After initiating the print 
option

Foreground

(print.fg)

Allows the operator to execute print 
request in foreground (i.e., 
operator’s terminal will be in a wait 
state until the report finishes). 

After initiating the print 
option.

Print

(print)

Allows the operator to begin the 
process of printing the currently 
displayed record.

Available on most RIO 
and FDISP panels.

Print List

(print.qbe)

Prints the current QBE List of 
records in QBE format.

From a QBE list of 
records.

Print Recs

(qberecs)

Prints the current QBE list of 
records in record format.

From a QBE list of 
records.
User Profile � 49



ServiceCenter
Printer

(printer)

An optional field that designates 
which printer that OCM generated 
print is routed to. This value is 
validated against the config file.

QBE List Report

(qbelist.report)

The report that is executed when 
you execute the print list option. The 
default is print.qbelist.bg

QBE list Format

(qbelist.format)

Defines format that is used when 
you select the print list option. The 
default is ocmx.qbe (where x is the 
area).

QBE Recs Report

(qberecs.report)

The report that is executed when 
you execute the print recs option. 
The default is print.records.bg

QBE Recs Format

(qberecs.format)

The format that is used when you 
select the print recs option. The 
default is ocmx.default (where x is 
the area).

Query Options

Active

(active.query)

Allows the operator to query for all 
active records (i.e., open=true) that 
match the QBE data. This option is 
displayed on the pagelist 
confirmation screen. The <enter> 
key on the initial query screen 
causes the query to search for all 
active tickets. If the operator does 
not have the authority to query for 
active records, a message is issued 
after the operator selects the 
<enter> key. 

During the process of 
querying for duplicate 
records. In GUI, the 
active query option is 
presented as a check box 
object.

Advanced Search

(query.window)

Allows you to search by narrowing 
the time frame when a record was 
opened or updated. You also can 
enter the names of the operators 
who opened or updated the report.

Control/Option
(Security Field 
Name) Description

When Available
Availability 
Conditions
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All

(all.query)

Causes the query to search for all 
records, regardless of status. 

Displayed on the initial 
query screen and when 
using the duplicate 
option.   In GUI, the all 
query option is 
presented as a check box 
object.

Clear

(clear)

Removes the previously entered 
QBE data and initializes the file 
variable (such as all of the data 
fields) to NULL.

For text, displayed on 
the secondary options of 
the initial query screen. 
In GUI, displayed in the 
Options pull-down.

Deferred

(deferred)

Amends the query to search for 
deferred items (such as 
open=unknown).

Displayed on the initial 
query screen and after 
invoking the duplicate 
option and the category 
query option. In GUI, 
the deferred query 
option is presented as a 
check box object.

Inactive

(history)

Allows the operator to query for all 
closed records (i.e., open=false) that 
match the QBE data. This option is 
displayed on the initial query screen 
and on the pagelist confirmation 
screen.

Displayed on the initial 
query screen and after 
invoking the duplicate 
function. In GUI, the 
inactive query option is 
presented as a check box 
object.

Modify Time 
Limit

(mod.time.limit)

Allows the operator to modify the 
Time Limit from the detect keyed 
warning prompt.

Partial Key

(partial.key)

Allows the operator to execute 
partially-keyed queries.

Restore

(qberestore)

Restores the previously entered QBE 
data to the currently displayed 
record.

Available on the initial 
query screen.

not null($lfilexsave)) 
(the clear option has 
been previously 
selected)

Control/Option
(Security Field 
Name) Description

When Available
Availability 
Conditions
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Skip Warning

(skip.warning)

Normally, it is desirable to warn a 
operator when they have entered an 
inefficient (partially or non-keyed) 
query. This option allows you to 
bypass this warning for certain 
operators. If the option is true the 
warning is bypassed. 

Standard

(standard)

This option is displayed after the 
operator has initiated the query 
option. This option causes the query 
to be built according to normal 
ServiceCenter query rules.

Displayed after selecting 
the query option but 
before the query 
window is opened.

Structured

(structured)

This option is displayed after the 
operator has initiated the query 
option. This option causes the query 
to be built according to OCM query 
rules. 

Displayed after selecting 
the query option but 
before the query 
window is opened.

Append Query

(append.query)

Defines the query string that is 
appended to all queries executed by 
the operator. OCM builds the query 
as: <standard query> and <append 
query>

Time Limit

(query.time.limit)

Defines the maximum amount of 
elapsed time that a query is allowed 
to execute.

Initial Format

(initial.fmt)

Defines the format name that is 
displayed to a operator when they 
first enter a given application. The 
default is ocmx.hdr1.

QBE Format

(qbe.format)

Defines the QBE format used to 
display records for a particular area

Control/Option
(Security Field 
Name) Description

When Available
Availability 
Conditions
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Category/Statement tab profile options
Restrict the operator/group to certain categories and allow for additional 
statements to be processed in relation to these restrictions. 

Figure 2-7: User Profile - Category/Statements tab

Control/Option
(Security Field 
Name) Description

When Available
Availability Conditions

Category 
Restrictions

Default Category

(default.category)

Defines the name of the Category 
that records are opened under 
when an operator opens a record 
for a particular area. If this field is 
NULL when an operator opens a 
record, then the operator can 
access only the Categories defined 
in the Allowed Cats field. This field 
is also used by the background 
order processor when generating 
orders. Refer to the section on 
Generating Orders. 
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Allowed 
Categories

(allowed.cats)

Defines the categories the operator 
is allowed to access. This controls 
which Categories are presented for 
the operator to select from during 
record open (if a Dflt Category is 
not defined) and controls which 
records the operator can view. If an 
operator attempts to select a record 
from a QBE list that is not one of 
these Categories, access is denied 
and the appropriate error message 
is sent. If no Categories are defined, 
the operator will have access to all 
Categories for that area.

Statements

(statements)

An optional array of processing 
statements that are executed when 
the security variables are 
established. This allows you to 
manipulate the default security 
variables and/or establish special 
security variables of your own. 

TIP: You can add your own fields 
to the profile record and then 
establish global variables via these 
processing statements. Use the 
ocmprofile.g file variable to refer to 
fields in the current OCM Profile 
record.

Control/Option
(Security Field 
Name) Description

When Available
Availability Conditions
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Queue Options tab profile options
Define whether the operator/group has a unique inbox in the various 
Request Management queues and allow for the specification of a unique 
queue format to display relevant quote or order records. 

Figure 2-8: User Profile - Queue Options tab

Control/Option
(Security Field 
Name) Description

When Available
Availability Conditions

Quote Initial Inbox

(quote.initial.inbox)

Defines the default inbox for the 
operator opening the quote 
queue.

Order Initial Inbox

(order.initial.inbox)

Defines the default inbox for the 
operator opening the order 
queue.

Line Item Initial 
Inbox

(line.initial.inbox)

Defines the default inbox for the 
operator opening the line item 
queue.

Quote Queue Format

(quote.manage.
format)

Defines the default queue 
format for the operator opening 
the quote queue.

Order Queue Format

(order.manage.
format)

Defines the default queue 
format for the operator opening 
the order queue.

Line Item Queue 
Format

(line.manage.format)

Defines the default queue 
format for the operator opening 
the line item queue.
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Adding a Profile
1 Open Request Management in the main ServiceCenter menu.

2 Click Supporting Files on the Maintenance tab.

3 Click Profiles under the Support structure. A blank operator profile form 
(ocmprofile) appears. See a sample ocmprofile form in Figure 2-4 on page 38.

4 Do one of the following:

� Begin entering the appropriate values for your user profile, based on the 
field and tab definitions above.

� Click Search from the system tray to pass a true query without entering 
any values in the form. A record list of existing profile records will display.

a Choose a profile you would like to base your new profile on, and open it 
by clicking the name.

b Enter a new profile name.

c Begin additional modifications to the record to create your new 
operator/group profile.

5 When you have completed setting up the values for this profile, click Add to 
add it to the ocmprofile file.

Important: Do not press SAVE, as this will copy over the record you changed 
with the new data and remove the old record from the 
ocmprofile file.

6 A series of screens prompt you with the values you have provided to the 
check boxes and tab fields in the expanded form, which displays true and false 
values. Do one of the following:

� Move through these screens by clicking OK as you verify the values are 
correct for the access rights you intend this user to have.

� When you have completed setting up the values for this profile, select 
Options > Rebuild Groups to apply this and other operator profile record 
group updates to the appropriate group definition records.

When the record is added or updated, a message the following message is 
displayed in the status bar:

*All Group Records updated to reflect latest Profile definition.
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Editing a Profile
1 Open an existing profile. See Adding a Profile on page 56 for information 

about searching for and opening an existing profile.

2 Review the restrictions for that profile.

3 Use the field and tab definitions described in Viewing a User Profile on 
page 37 to determine the exact restrictions or permissions you wish to enable 
for the user.

4 Do one of the following:

� Click Save in the system tray to confirm and record your revisions to the 
record.

� When you have completed setting up the values for this profile, pull down 
the Options and select Rebuild Groups to apply this and other operator 
profile record Message group definition updates to the appropriate 
Message group definition records.

Group Records

A group in Request Management represents a collection of operators who 
share a common set of responsibilities. Group definitions specify two 
divisions within the group: operators who are members (reviewers), and 
operators who have approval authority and receive approval information 
associated with this group (may be the same as the members). 

One of the primary purposes of this grouping is for dissemination of system 
messages to relevant parties. Member groups (reviewers) or Approval groups 
may be listed in the ocmevents record, but if these groups are not also listed 
in the Group record, they will not receive messages. The individuals of a 
group will have the same authority as identified in their profile, but they 
simply will not receive messages.

An operator’s authority depends on the operator profile; whether an 
operator receives messages depends on membership in the group record.

Viewing Group Records
1 Open Request Management from the main ServiceCenter menu.

2 Click Supporting Files on the Maintenance tab.

3 Click Groups in the Support structure.
Group Records � 57



ServiceCenter
A blank group definition form (ocmgroups) is displayed.

4 Click Search to pass a true query and retrieve all current user profiles.

A record list of available group definitions is displayed above the data from 
the first record.

5 Select a profile to view from the list by clicking on the name. Figure 2-9 shows 
the selected record.

Figure 2-9: Group Definition
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The definition form (ocmgroups) displays the specific operators who receive 
member messages and approval messages for this group.

Adding Group Records
1 Open Request Management from the main ServiceCenter menu.

2 Click Supporting Files on the Maintenance tab.

3 Click Groups under the Support structure. A blank group definition form 
(ocmgroups) appears, as shown in Figure 2-9 on page 58.

4 Do one of the following:

� Begin entering the appropriate values for your group definition record, 
based on the field definitions described in Viewing Group Records on 
page 57.

� Click Search to pass a true query and retrieve all current group definition 
records.

Field Description

Name
(required)

Identifies the name of the group; usually reflects the name of the 
department. Must be unique within each Request Management 
area.

Area The functional area for this group record. Valid values include 
Quotes, Orders, Line Items, and All.

Description Description of the group.

Duty Table Name of the Duty Table that defines the working hours of this 
group. Used by the Alert processor when scheduling alerts (for 
example, determines which shifts are valid for sending alerts to 
these operators).

Members The login IDs of operators who are members (reviewers) of this 
group and who will receive messages when the ocmevents 
Member List field contains a value of members or all. Select 
Options > Rebuild Groups to update this Members list to 
include any profile record group additions or changes made in 
the profile record.

Approvers The login IDs of operators who are approvers of this group and 
who will receive messages when the ocmevents Member List 
field contains approver or all. Select Options > Rebuild Groups 
to update this Approvers list to include any profile record group 
additions or changes made in the profile record.
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� Choose a group definition which you would like to base your new 
group on and open it by clicking the name.

� Enter a new group name.

� Begin additional modifications to the record to create your new group 
record.

5 Select Options > Rebuild Groups to update the Members and Approvers lists 
to include any profile record Message group additions or changes made in 
the profile record.

6 Click Add to confirm and record your new group record.

Editing Group Records
1 Open an existing record, as described in Viewing Group Records on page 57.

2 Review the membership and approval lists for that Message group definition.

Note: All membership additions or deletions are made through the operator 
profile record group changes. For more information on editing profile 
records, see Editing a Profile on page 57.

3 Select Options > Rebuild Groups to rebuild all group definition lists after the 
operator profile records have been updated.
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CHAPTER

3
 Catalog Operations
The catalog is the first step the operator encounters in the request process. 
Creating the catalog is one of the most important steps in the Request 
Management setup process. See Pre-Implementation Planning on page 211 
for detailed explanations about what you will need to build your catalog.

This chapter addresses the following issues in relation to setting up and using 
the Request Management catalog.

� Overview on page 62

� Primary Files on page 62

� Categories on page 63

� Phantom Line Items on page 72

� Phases on page 75

� Model File on page 90

� Modelvendor File on page 113

� Vendor File on page 118
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Overview

Within the catalog are the list of items and bundled items available for 
request. These items and categories of items need to be set up by an 
administrator with rights to create catalog items. Most operators will only be 
allowed to access existing catalogs, and will not have editorial control in the 
process, such as not having the ability to add items to the catalog that are not 
already defined.

Primary Files

The catalog consists of the model, modelvendor and vendor files.

Model (Catalog) File
The model file (also known as the catalog file) contains a detailed bill of 
materials for a part. This includes the hardware, software and services that 
comprise the item, as well as controls on the part and its components. The 
file contains information regarding what operators can do with the part, how 
components of this part are selected, how quote line items turn into orders, 
and whether to order or to consume from stock. Both the model.g form and 
the ocmco.g form can be used to display data contained in the model file.

The catalog defines an item’s components and their order generation 
dependencies. Controlling the order generation dependencies includes the 
purchase requisition and service and work orders necessary to obtain the 
item. 

The following field controls the grouping of these items:

Type: Category is the primary grouping for Catalog items. Allows grouping 
of similar items under a common name.

Modelvendor File
The modelvendor file is a bridge between the model and vendor files. It 
contains relational information between a particular part or model, and the 
associated vendor(s) of that part. Data regarding cost, lead times, and 
payment schedules for a vendor are tracked along with the parts.
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Vendor File
The vendor file is shared throughout ServiceCenter as the source of 
manufacturer and retail vendor information. It also holds data on internal 
and external service providers. A vendor record for a particular 
manufacturer must exist before items from this manufacturer can be 
admitted to ServiceCenter inventory and, consequently, the Request 
Management catalog.

Categories

Categories within Request Management help to group items that would 
normally be listed independently. Without these groupings, seeking out 
items and services when ordering would make the request process more 
time-consuming.

Request Categories
ServiceCenter has three out-of-box request categories from which you can 
choose to procure assets, order new employee items and services, and 
accomplish an employee office move. When you open a quote, you are 
presented with the following out-of-box Request category selections:

� Customer Procurement Requests

� Human Resources

� Employee Office Move Process

Once you select a Request category, you are presented with the master catalog 
categories.

Master Catalog Categories
Master catalog categories provide a ‘bundled’ approach to ordering from the 
catalog. This ‘bundled’ approach helps to group like or related bundled 
categories and line items. For example, labor can be logically grouped within 
more than one master category, whereas otherwise it might be overlooked, 
creating problems if it’s ordered too late in the process.
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Master categories and line items are those items displayed directly after the 
request categories. For example, when you choose request category Customer 
Procurement Requests, ServiceCenter displays the Master Catalog shown in 
Figure 3-1. 

Figure 3-1: Master Categories in the Catalog

The master catalog categories are grouped, so that you can combine the 
necessary items and related services. For example, selecting Computers & 
Related serves to group the following item types and services: Computer 
Accessories, Desktop Computers, Handheld and PDAs, Hardware Requests, 
Request Hardware Upgrades, Installation Services, Individual Monitors, and 
Notebook Computers. So if you are ordering a computer monitor, you need 
to select Individual Monitors. 

As an out-of-box example, the summary of New Employee Setup includes 
furniture, computer equipment, installation services, and so forth. You can 
add items to or take away from this bundled order, as needed.

Adding Master Categories
When you create a master category for the catalog, you begin a process which 
contains ever-increasing levels of specification. The general master category 
will be created in the following steps, but you will be adding other items 
(created later in this guide) into this category.
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To create a master category:

1 Click Request Management in the ServiceCenter home menu.

2 Click Administration in the Maintenance tab.

3 Click Master Category in the Line Items tab. Figure 3-2 shows the 
ocmcatselect form.

Figure 3-2: Configuring A New Master Category

4 Enter the required unique name for this master category in the Name field.

5 Enter a short description of this catalog item in the Description field (no 
more than 30 characters in length). This description is displayed on record 
lists and should be meaningful for operators.

6 The condition evaluated during adding a line item process to determine if the 
operator can select items under this master category. Decide whether you 
want operators to have the option of selecting this category while adding a 
line item. Enter true in the Availability field if the operator is to have this 
control; leave the field blank if the operator is not to have this option, as this 
control defaults to false if left blank; or use a condition to create a more 
variable availability control (see note below).
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Note: The variable $lo.ucapex can be used to search for operator/group 
capability words and whether this master category will be available to 
particular operators. It can be used in the Availability field as part of a 
condition, such as:

  index(“Capability words”,$lo.ucapex)>0

7 The condition evaluated after the operator selects the master category to 
determine if the list of line item categories under this master category is 
displayed. Decide whether you want operators who select this category to 
have the option to see which line items of the category will be included in the 
quote. Enter true in the Display Categories field if the operator is to have this 
option; leave the field blank if the operator is not to have this option, as this 
control defaults to false if left blank. If false, the line item category record list 
is not displayed; instead, all parts (or line items) with a line item category 
matching any of this master category’s line item categories is displayed.

8 If you are using Get.Resources! with ServiceCenter, you can modify which 
icon will be used in the Get.It! Icon field. Search your browser and enter the 
path. For example:

icons/cataccessories.gif

9 Determine the sequence to sort the list of parts for this category.

Note: You can modify the sort order within the Sequence field by selecting 
the category key in the model file.

10 Determine which Quote Categories (request quotes -- types of requests) will 
access this master category and display this line item in the catalog. If left 
blank (NULL), this category will be available for all request quote categories. 
In the default system, there are three Request Management quote categories. 
(You can return to the record later to add additional Quote categories, if you 
do not know the names of the categories at this time.)

To display a list of available quote categories:

a Place the cursor in the first field of the array and click Find.

b Choose a category from the displayed list.

c Click on the category name to display the quote category record 
definitions.

d Make note of the category name, as you will have to enter the name later 
in the Quote Categories field (array).
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e Once you have selected the appropriate request category where this new 
master category quote will belong. Click OK then Back to return to the 
master category form.

11 Enter the name of this category in the Quote Categories field (array).

12 Determine which Order Categories will access this master category and 
display this line item in the catalog. If left blank (NULL), this category will be 
available for all operator order categories. Currently there are five default 
order categories. (You can return to the record later to add additional Order 
categories, if you do not know the names of the categories at this time.)

To display a list of available order categories

a Place the cursor in the first field of the array (Order Category Name field), 
and click Find in the system tray.

b Choose an order category from the displayed list.

c Click on the category name to show the order category definitions.

d Make note of the category name, as you will have to enter the name later 
in the Order Categories field (array).

e Once you have selected the appropriate order category, click OK then 
Back to return to the master category form.

13 Add the name of this category to the Order Categories array.

14 Determine which line item categories are to be available in this master 
category. These are the smaller groupings of products and services which 
organize the available pool of resources. Currently there are just over 80 
default line item categories. If you leave this field blank, all the line item 
categories will be available to this master category.

To display a list of available line item categories:

a Place the cursor in the first field of the array, and click Find in the system 
tray.

b Choose a line item category from the displayed list.

c Click on the category name to show the line item category definitions 
(must be defined in the ocmlat file).

d Make note of the line item category name, as you will have to enter the 
name later in the Line Item Categories field (array).

e Click OK then Back to return to the master category form.

15 Add the name of this category to the Line Item Categories array.
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16 Click Add to record the new master category.

Once added, you will receive the following message in the status bar:

ocmcatselect record added

Viewing Master Categories

To view a master category:

1 Click Request Management in the ServiceCenter home menu.

2 Click Administration on the Maintenance tab.

3 Click Master Category on the Line items tab. A blank master category record 
form (ocmcatselect) appears, as shown in Figure 3-2 on page 65.

4 Pass a true query by clicking Search, or enter a value in the form and press 
Enter to call a specific master category record.

5 A record list displays, along with the details of the first record. Double-click 
another master category record to select it from the list. The selected master 
category record appears. The field definitions on the ocmcatselect form are 
defined in Adding Master Categories on page 64.

Line Item Categories
Line item categories are the smaller and more numerous catalog item 
categories. Line item categories are the building blocks of the master 
categories; however, they are still categories, built of smaller pieces: parts. 
The smaller pieces in this case are individual line items, such as, an ACME 
mouse or an ABC 17” monitor. The two items in the example could be found 
in a line item category called Computers & Related along with many other 
individual line items associated with a computer setup procedure.

Line item categories can be restricted to certain quote and order groups just 
as can the master categories. Based on the line item categories named as 
available in the master category selected on the first page of the catalog, the 
line item categories are displayed in subsequent pages of the catalog.

Selecting a line item category from the catalog presents a list of actual line 
items, or parts, available for that category.
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Adding Line Item Categories 
The line item category is the next step down in specification from the master 
category. Line items are more numerous and specific to the individual groups 
of products a company holds in inventory than are the master categories. 
Line items include both specific parts and services.

To add a line item category:

1 Click Request Management in the ServiceCenter home menu.

2 Click Administration on the Maintenance tab.

3 Click Create Category on the Line Items tab. Figure 3-3 shows the ocmlcat 
form.

Figure 3-3: Adding line item categories

4 Most of the ocmlcat form fields shown in Figure 3-3 have already been 
explained. For more information, see Adding Master Categories on page 64. 
See the rest of the steps in this sequence for the other field explanations.

5 Enter the QBE Format, if you will be using a different format other than the 
default ocml.qbe form.
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6 Decide whether or not you want to check the Assign Number Before 
Commit? field box before adding this category line item. If checked (true), 
the system assigns a number to the line item before displaying a confirmation 
screen (if that display option is activated). If left blank (NULL), defaults to 
false.

7 Bitmaps can be stored in the ServiceCenter repository and displayed on any 
of the GUI client platforms. For example, pictures of inventory items can be 
stored. The List Bitmap field lets you add a bitmap that can be displayed on 
your ServiceCenter form by simply adding a holder for the bitmap on the 
form.

8 Enter the (required) name of the phase for this category in the Line Item 
Phase field. This name will automatically be defaulted through Format 
Control to match the category name.

9 Click Add to save the new line item category.

Important: This item will not function properly until a phase definition 
record of the same name has been committed to the database. 
See Adding Phases on page 76 for details on adding a phase 
record.

When the new line item category is saved, the Line Item Category record is 
added, and then you are prompted for values to add an associated phase 
definition record, as shown in Figure 3-7 on page 77. See Adding Phases on 
page 76 to complete this task.

Viewing Line Item Categories
To view a line item category:

1 Click Request Management in the ServiceCenter home menu.

2 Click Categories on the Line Items tab. A blank Line Items Category form 
(ocmlcat) appears, as shown in Figure 3-3 on page 69.

3 Pass a true query by clicking Search without entering any values in the blank 
form, or enter a value in the form and press Enter to call a specific line item 
category record. 
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Figure 3-4 shows a list along with the first item in the list ().

Figure 3-4: Line Item Category Definition

4 Select other category records, as needed.

5 Most of the ocmlcat form fields shown in Figure 3-4 are described in Adding 
Master Categories on page 64. See the rest of the steps in this sequence for the 
other field explanations.

6 Enter the QBE Format, if you are using a different format other than the 
default ocml.qbe form.

7 Decide whether or not you want to check the Assign Number Before 
Commit? field box before adding this category line item. If checked (true), 
the system assigns a number to the line item before, displaying a 
confirmation screen (if that display option is activated). If left blank (NULL), 
defaults to false.
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8 Bitmaps can be stored in the ServiceCenter repository and displayed on any 
of the GUI client platforms. For example, pictures of inventory items can be 
stored. The List Bitmap field lets you add a bitmap that can be displayed on 
your ServiceCenter form by simply adding a holder for the bitmap on the 
form.

9 Enter the (required) name of the phase for this category in the Line Item 
Phase field. This name will automatically be defaulted through Format 
Control to match the category name.

10 Click Add to save the new line item category.

Note: Users may want to establish multiple line item categories that use the 
same phase name (especially if the categories will all be using the same 
options and formats established in the Phase definition). For more 
information, see Phases on page 75.

Phantom Line Items

Phantoms are place holders, or pseudo parts, used to organize a collection of 
multiple items. They are used to provide flexibility in defining component 
relationships within the catalog, and are usually not physical items. A 
phantom can be considered an umbrella type of level for several parts 
selections of the same type. An example of a phantom line item is the New 
Accounts & Access line item. Beneath the New Employee Setup master 
category, the New Accounts & Access line item provides a selectable option. 
This item itself does not display on the quote or order when it is selected, but 
each of the associated parts below are displayed as individual line items, such 
as internet access, email account, and network ID.

The phantom part is a parent of the specific items within it, so that the 
specific items (or parts) are selected through the phantom part.

Phantoms are assigned part numbers, but they themselves usually are not 
ordered or placed on a quote.

There are two ways to designate a listing as a phantom:

To select Phantom in the Reorder Type field in the Reorder Information tab 
on the model form:

1 Click Request Management on the Services tab of the ServiceCenter home 
menu.
72 �Chapter 3—Catalog Operations 



Request Management Guide
2 Click Supporting Files on the Maintenance tab of the Request Management 
home menu.

3 Click Model on the Catalog tab.

4 Do one of the following:

� Select Phantom in the Reorder Type field in the Reorder Information tab 
on the model form, as shown in Figure 3-5.

Figure 3-5: Select Reorder Type to designate a listing as a phantom

� Create a line item category of phantom (see Adding Line Item Categories on 
page 69). 

There are three types of line items, as shown in Line Item Types on page 74.

� Type 1 represents the Catalog Part (part or service) that is actually 
ordered.

� Types 2 and 3 represent two kinds of phantoms. Type 2 is an intermediary 
invisible part:

� Used to group several related parts without all the parts displaying on a 
list, controlling the size of the pick list.
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� Its line item category is usually phantom.

� Is itself not added to the quote.

� Used for the selection of its children parts.

Type 3 is a high-level part:

� Its line item category is a phantom, but with a specific category.

� Used to select high-level items that may or may not be added to the 
quote.

Line Item Types

Type
Model/V
endor?

Line Item 
Category

Copy to 
Line Item? Description Parent/ Child?

1 Yes Category 
Specific

Yes Represents a part or 
service

Optional 
children

2 N/A Phantom No Used to group types 
1, 2, or 3

Always has 
children

3 N/A Category 
Specific

No A phantom (2) with 
a specific category, 
so that it can be 
selected from the 
Master Category. 
Used to group types 
1, 2 and 3.

Always has 
children
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Figure 3-6 shows an example of a Type 2 line item category, category-specific 
phantom with its model record (ocmco).

Figure 3-6: Phantom Line Item Definition

This part (100) has three components (children) of the New Employee Setup 
master category. Its category is phantom. Each item, which is to be added as 
a line item when this phantom item is selected, will be a child of the New 
Accounts & Access master category.

Phases

Phases determine when and how quotes, line items, and orders, are 
processed. Phases control the activity allowed during that administrative step 
in the business process flow.

With a quote category, a phase indicates where in the process the quote 
currently stands, and who can modify the quote. A typical implementation 
has one quote category with two to three phases, such as initial phase- for 
setting up the quote with approvals, ordering phase- for order generation, 
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and QA phase- for verifying successful fulfillment. In the case where a phase 
exists for the operator who submitted the quote to verify his or her 
satisfaction, an operator approval phase could be set up, restricting the close 
or approval control of the quote to a request coordinator who must contact 
the originating operator to verify that the operator approves of the quote.

Not all operators have access to quotes and orders at all stages of the process. 
Typically, an implementation sets up one phase per order category, 
providing specific instruction for that category. Each line item category has 
only one phase, which defines the system behavior when that line is selected 
and processed.

Adding Phases

Quote Phases
To add a quote phase:

1 Open the Request Management menu on the ServiceCenter home menu.

2 Click Quote Phases on the Quotes tab.

A blank phase definition form (ocmoptions.q) displays.

3 Pass a true query by selecting Search without providing any additional 
information in the form. 
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Figure 3-7 shows a list of existing quote phase definitions.

Figure 3-7: Quote Phase Definition

4 From this list, select a phase definition you wish to base your new phase on 
by clicking the phase name. The phase definition (ocmoptions.q) form 
appears, containing the definition data of the selected quote phase.

5 Modify the phase record with your information by providing necessary 
information on each of the seven tabs, relevant to the system behavior and 
level of control you want an operator to have on a quote in this phase. For 
example. 

The tabs and the fields within these tabs on the Phase Definition screen are 
described in Quote Phase Definition Fields on page 78.

6 Click Add to save and add the new phase to the system.

7 Do one of the following:

� When prompted (status bar at the bottom of the window displays a 
message that states: Ready), click Add To All, shown in Figure 3-8 on 
page 78, to select all events for this new phase definition. 
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� If you want to restrict the phase to only some events, select them at this 
time and do not click Add To All. Instead, click Back to include only these 
events and return to the Request Management menu.

Figure 3-8: Selecting an event for a new phase

Quote Phase Definition Fields

Definition tab
The Definition tab shown in Figure 3-7 on page 77 lists the control options 
available to an operator to modify this line item.

Risk Area

Field Description

Maximum Defines the maximum value of risk that can be set from the risk 
calculation.

Calculation True or false condition.

True calculates the risk for the current record (calculation is 
based on the same logic used in CM3 for Change Management 
when determining the risk calculation). 

False does not perform a risk calculation.
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Admin Area

History Area

Controls tab

The Controls tab lists the options to be available for the operator to modify 
the quote by updating or approving it. Values here can be true, false, or a 
conditional statement. A conditional statement should use $L.file as the 
reference to the current record.

Figure 3-9: Controls tab

Field Description

Lead Time The number of days advance notice required to deliver the 
product or service. Expressed as a date/time relative to current 
date/time and to Duty Table.

Duty Table The name of the Calendar Duty Table that Lead Time is 
calculated against in order to arrive at a date. If NULL, the 
system calculates Lead Time against a 24/7 time table.

Field Description

Pages Allows (true) or disallows (false) listing all the pages associated 
with a quote.

Page Link The link to be used to copy the fields from the current record to 
the page file. If there is no link specified, all fields will be moved.

Audit Records Allows (true) or disallows (false) audit records to be added for 
the record whenever it is modified.
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Controls Area

Field Description

Update Allows (true) or disallows (false) the operator to update a 
quote within this phase.

Approval Allows (true) or disallows (false) the operator to approve a 
quote within this phase.

Close Allows (true) or disallows (false) the operator to close a quote 
within this phase.

Close Description The description of the option that is used to close the phase 
(such as, Close or Next Phase).

Reopen Allows (true) or disallows (false) the operator to reopen a 
quote within this phase.

Messages/Events Allows (true) or disallows (false) the system to send a message 
event within this phase.

Generate Orders Allows (true) or disallows (false) orders to be generated 
within this phase.

Confirm Action Allows (true) or disallows (false) confirmation on an action in 
a quote within this phase.

Close if Last LI 
Closed

Allows (true) or disallows (false) a quote to be automatically 
closed if the last line item is closed within this phase.
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Alerts tab

The Alerts tab indicates which alerts are applicable for this line item.

Figure 3-10: Alerts tab

Alert Controls Area

Field Description

Alert Alerts on file. Put your cursor in this field and click Find to search 
a current list of alerts with their descriptions to find an applicable 
alert or click Fill to bring up the current list of alerts and 
double-click an alert to select it from the list.

Field Description

Reset Resets all alerts and recalculates all possible alerts.

Reeval Reevaluates the current active alerts to determine if they are still 
valid.

Retain Retains current alerts when the phase changes.
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Approvals tab
The Approvals tab lists those groups comprising approval requirements for 
this line item.

Figure 3-11: Approvals tab

Approval NameApproval Definitions on file. Click Find to search a current 
list of Approvals with their conditions and descriptions to find an 
applicable Approval. Put your cursor in the field and click Fill to bring up 
the current list of Approval names and double-click an Approval name to 
select it from the list.

Approval Controls Area

Field Description

Reset If set to true, resets all approvals and reevaluates the 
conditions on all possible Approval Definitions.

Recalc If set to true, recalculates the Approval Definitions for all 
current approvals.

Retain If set to true, retains current approvals if the phase changes. 

Use Line Item/Model 
Approvals

Additionally calculate approval conditions for the 
meanings in the line item and model definitions.
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Model/Line Items tab
The Model/Line Items tab provides the ability to specify a model quote or 
order and line item rules.

Figure 3-12: Model/Line Items tab

Model Area

Line Item Controls

Field Description

Model The number of the model quote or order.

Link Link record to be used to copy information from the model 
record into the current record.

Field Description

Add Allows (true) or disallows (false) line items to be added within 
this phase.

Auto Close Allows (true) or disallows (false) line items to be automatically 
closed within this phase.

Note: Especially important on this tab are the next two fields, Auto Mark Avail to 
Orders and Manual Mark Avail to Orders.

Auto Mark Avail. 
to Orders

If set to true, defines when the system should mark the quote 
line item as available for order processing.
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Scripts/Views tab
The Scripts/Views tab provides information for special scripts to be used 
when a line item of this phase is opened, updated, closed, and so forth, and 
to set up the default view for displaying information on the line item in this 
phase. Initially, there is an out-of-box default view already set up in the 
Default View field.

Figure 3-13: Scripts/Views tab

Scripts Area

Manual Mark 
Avail. to Orders

If set to true, controls when this menu option is available to the 
operator to mark the quote line item as available for order 
processing.

Find Subtotals Allows (true) or disallows (false) line items to be subtotaled 
within an order.

Field Description

Pre Catalog Open The script to be used when an operator begins to open a 
new quote, before the catalog is accessed.

Post Catalog Open The script to be used when an operator has selected items 
from the catalog.

Update The script to be used during the update process for the 
operator to provide further comments on the record in 
this phase.

Close The script to be used during the close process for the 
operator to provide further comments on the record in 
this phase.

Field Description
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Line Item Phase
To add a line item phase:

1 Open the Request Management menu.

2 Click Line Items tab.

3 Click Line Item Phases on the Line Items tab.

A blank phase definition form (ocmoptions.l) displays.

Reopen The script to be used during the reopen process for the 
operator to provide further comments on the record in 
this phase.

Copy & Open The script to be used during the copy and open process for 
the operator to provide further comments on the record in 
this phase.

Condition Conditional settings for the scripts. For example, the 
reopen condition must evaluate to true before the reopen 
process occurs.

Default View The default view set up for the record in this phase.

Field Description
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4 Pass a true query by clicking Search without providing any additional 
information in the form. Figure 3-14 shows a list of existing line item phase 
definitions.

Figure 3-14: Line Item Phase Definition

5 From this list, select a phase definition to base your new line item phase on 
by clicking on the name. The phase definition (ocmoptions.l) form appears, 
containing the definition data of the selected line item phase.

6 Modify the phase record with your information. See the information 
provided about the tabs described in Quote Phases on page 76. See also other 
differences described in the explanations and notes listed below.

� The Reports tab lists the specialized Crystal Reports, which are to be run 
on issues, such as performance and order-to-receipt time, related to a line 
item in this phase. 
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� Especially important on this form is the Parent Area field that designates 
which parent area must be valid for a line item under this phase. If NULL 
(left blank), all line items under this phase will use this phase definition.

� When the Modify Dates field in the Line Item Controls structure is true, 
this allows you to change the ordering dates of a line item; if false, the dates 
cannot be modified. If left blank, the default value is false.

7 Click Add to save and add the new phase to the system.

8 Do one of the following:

� When prompted (status at the bottom of the window displays a message 
that states: Ready), click Add To All to add this new line item phase 
definition to all events. See Figure 3-8 on page 78.

� If you want to restrict the phase to certain events, select only those events 
and click OK. (Do not click Add To All.)

Order Phase
To add an order phase:

1 Open the Request Management menu.

2 Click Orders tab.

3 Click Order Phases on the Orders tab.

A blank phase definition form (ocmoptions.o) displays.

4 Pass a true query by clicking Search without providing any additional 
information in the form. Figure 3-15 shows a list of existing order phase 
definitions.

Figure 3-15:  Order Phase Definition
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5 From this list, select a phase definition to base your new order phase on by 
clicking on the name.

The phase definition (ocmoptions.o) form displays, containing the definition 
data of the selected order phase.

6 Modify the phase record with your information. See the information 
provided about the tabs described in Quote Phases on page 76.

Note: The Reports tab lists the specialized Crystal Reports, which are to be 
run on issues, such as performance and order-to-receipt time, related 
to an order in this phase. 

7 Click Add to save and add the new phase to the system.

8 When prompted (status at the bottom of the window will display Ready), 
click Add To All to add this new line item phase definition to all events. See 
Figure 3-8 on page 78.

9 If you want to restrict the phase to certain events, select only those events and 
click OK. Do not click Add To All.

Viewing Phases

Quote Phase
To view a quote phase:

1 Open the Request Management menu.

2 Click Phases on the Quotes tab.

A blank phase definition form (ocmoptions.q) for quote phases displays.

3 Pass a true query by selecting Search without providing any additional 
information in the form. A list of existing quote phase definitions appears as 
shown in Figure 3-7 on page 77, along with the first record in the list.

4 From this list, select a phase definition to view by clicking on the name.

The phase definition (ocmoptions.q) form contains the definition data of the 
selected quote phase.

Each of the tabs contains information relevant to system behavior and the 
level of control an operator will have on a quote in this phase. See the 
information provided about the tabs described in Quote Phases on page 76.
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Line Item Phase
To view a line item phase:

1 Open the Request Management menu.

2 Click Line Item Phases on the Line Items tab. A blank phase definition form 
(ocmoptions.l) for line item phases appears, as shown in Figure 3-14 on 
page 86.

3 Pass a true query by selecting Search without providing any additional 
information in the form. A list of existing line item phase definitions appears.

4 From this list, select a phase definition to view by clicking on the name.

The phase definition (ocmoptions.l) form contains the definition data of the 
selected line item phase. See the information provided about the tabs 
described in Quote Phases on page 76. See other explanations and notes 
below.

� The Reports tab lists the specialized Crystal Reports, which are to be run 
on issues, such as performance and order-to-receipt time, related to a line 
item in this phase. 

� Especially important on this form is the Parent Area field shown in 
Figure 3-14 on page 86, because it designates which parent area must be 
valid for a line item under this phase. If NULL (left blank), all line items 
under this phase will use this phase definition.

� When the Modify Dates field in the Line Item Controls structure shown 
in Figure  on page 86 is true, this allows you to change the ordering dates 
of a line item; if false, the dates cannot be modified. If left blank, the default 
value is false. 

Order Phase
To view an order phase:

1 Open the Request Management menu.

2 Click Phases on the Orders tab.

A blank phase definition form (ocmoptions.o) for order phases displays.

3 Pass a true query by selecting Search without providing any additional 
information in the form.

A list of existing order phase definitions is displayed.
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Note: Figure 3-16 shows the list that appears when Record List in the View 
menu is not selected (unchecked).

Figure 3-16: Order Phases view

4 From this list, select a phase definition to view by clicking on the name.

The phase definition (ocmoptions.o) form contains the definition data of the 
selected order phase.

Each of the tabs contains information relevant to system behavior and the 
level of control an operator will have on an order in this phase.

Model File

The model (catalog) file defines the components an operator may order, using 
the unique key of Part Number to separate items. The file also contains all 
associated component relationships within the catalog.

The model record contains information, such as:

� The rules for processing this component when it is a line item as part of a 
quote or order.

� References to component parts included with this parent.

� The names of approval definitions that this component must have when it 
is added to a quote or an order.

� If this part has components, the rules for selecting the dependent 
components.

� The quantities of this component that are in use, on hand, on order, and 
so forth.
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The information in the model record is copied to the quote line item.

Views
The model file has two different format views available:

� ocmco (the catalog view)

� model (the model view)

Catalog (ocmco or ocmo.detail) View

The ocmco (the co stands for component) form is one of the ways of viewing 
the model file. It displays the runtime processing control options for each 
part and the relationship of one part to another. Each item has its own unique 
component definitions.

To view a file:

1 From the main Request Management menu, click Supporting Files on the 
Maintenance tab.

2 Click Catalog in the Catalog tab.

From this approach the Request Management Component Definitions 
default form (ocmco) appears, as shown in Figure 3-17.

Figure 3-17: Device Information in ocmco view
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3 To display alternative views of a record, pass a true query by clicking Search, 
or call up a specific record.

4 Click Views in the system tray. The list of alternate views is displayed.

Figure 3-18: Optional ocmo list.views

Use the following field definitions to identify the type of data required and 
provided on the ocmco form:

Field Description

Part No The unique identifier of the particular component. Linked 
to the Parent field so that Find returns any components of 
this item.

Desc
(required) 

Brief description, used for QBE and record lists.

Manufacturer
(required)

The manufacturer of this component; validated against 
the vendor file. (Same as on model form.)

Model
(required)

A unique definition for the component, usually defined by 
the manufacturer. (Same as on model form.)

LI Category The line item category to which this part is associated. 
Each part in the catalog must belong to a line item category 
(same as on model format).

Default Priority The order in which items are presented for selection when 
a part is being selected from the Catalog during the line 
item open process.

Show Vendors button Finds all vendors for this item and presents the associated 
modelvendor records.

Model Ext Displays extension applied to model number for more 
specific identification.
92 �Chapter 3—Catalog Operations 



Request Management Guide
Components tab
The information in this tab gives details about this part. See the Components 
tab shown in Figure 3-17 on page 91.

Assigned Dept If requests for this part are always assigned to the same 
department, you can enter that department here.

Default Quantity The default number of parts to be ordered. If the field is 
left blank, the default number is set to one.

Field Description

Group The name of the group to which this part is linked.

Part Number The sequence of the numbering scheme for this part.

Description A brief description of this part.

Quantity The number of parts to be ordered for this part. If the field is 
left blank, the default number is set to one.

Category The category, or categories, to which this part is associated.

Option Type The option type for the grouping order of this part.

Required, default, or optional.

Field Description
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Dependencies tab
The information in this tab forms a grouping order, creating dependencies 
according to how groups are set up and setting up dependency types.

Figure 3-19: Dependencies tab

Part Conditions tab

Figure 3-20 shows the Part Conditions tab.

Figure 3-20: Part Conditions tab

Field Description

Group Name Define the primary grouping for catalog items and parts.

Dependent On Set up dependencies according to how parts are grouped.

Dependency Type Select a dependency type, according to your stockroom 
options. When a part is received, it may be marked as:

“in stock” and left active
-or-
“closed”

This depends on your office workflow.
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Conditions for This Part Area

Field Description

User Select? A field to control when the operator can select this particular 
item. If true, the operator can select the item during the quote 
open process; if not, the item will not display for selection.

Show Summary? Controls whether the operator is shown a preview of a part’s 
sub-components before proceeding to part and vendor 
selection.

Show Confirm? Controls whether the operator is shown the selected parts 
summary and confirmation screen after making part/vendor 
selections.

Copy to LI? Controls which Catalog entries are opened as line items. For 
instance, “phantoms” would normally not be copied to a line 
item, so this field would usually be set to false for phantoms; 
however, it may be beneficial for clarity of the structure of an 
item to copy the phantom. 

Note: If the Defer Selection field in the Component 
Conditions tab is true, the entry is always copied to the line 
item regardless of the value in the Copy to LI? field.

Generate Order? A field to allow control over which quote line items are 
available for order processing.

Create Unique? Controls if the system creates some number of unique line 
items for this part, based on the quantity defined in the Parent 
Qty field.

Consolidate 
Parent?

Controls when this part is consolidated to the Parent Part, 
that is, where the parent line item field points to the line item 
number that was opened to fulfill the requirements of this 
Part’s parent. If true, on-hand inventories for this part or the 
parent cannot be consumed. 

Select Vendor? Controls when operators are responsible for selecting the 
vendor for the items they select. If vendor selection is 
deferred, someone else (normally the coordinator of the line 
item or quote) must access the line item and manually select 
a vendor.

User Modify 
Quantity?

Controls when the operator can override the default ordering 
quantities during the line item open process.
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Component Conditions tab

Figure 3-21: Component Conditions tab

Conditions for the Components of This Part Area

Field Description

Prompt Message A character field to control the message sent to the 
operator prompting a selection of the sub-components of 
this particular item. If NULL, the system sends the 
message, These are the available options for Part <part 
number> <part description>.

Can Select One? -- Can 
Select Many? -- Can 
Select None?

Fields that control how many components of this 
particular item the operator can select during the line item 
open process.

Defer Selection Controls when the operator selects the components of an 
item. If true, the operator does not select the components.

Auto Select All 
Defaults?

Defines if the system should automatically select the 
default components of this particular item.
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Approvals/Alerts tab

Figure 3-22: Approvals/Alerts tab

Receiving/Posting tab
If you are receiving parts and logging them into ServiceCenter, you need to 
set up the information in this tab.

Field Description

Approval Names The approval groups or individuals who must approve the 
Quote when this item (Part) is opened as a line item 
definition.

Defining this field at the part level (rather than at a phase 
level within a category) provides a way to differentiate 
particular line items for approval. For instance, if two parts 
are in the same line item category but one has a NULL value 
in this field and the other has a valid Approval group defined, 
the latter will require approval by that group.

Alert Names The alert definition that will be scheduled for processing 
when this item (part) is opened as a line item.
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Figure 3-23: Receiving/Posting tab

Field Description

Receiving Format How this part is to be received from the vendor.

Asset Tag # Name Create an asset tag number name to identify the part when 
it is received.

Field Name The field name where the receipt information is to be 
logged.

Field Description A brief description of the field.

Required? Is this information required? (True=yes, false=no.) If left 
blank, the default is false (no).

Default Value The value of this part. If left blank, the default is zero.

Data Type What data type, so that queries can be performed.
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Available Options

Summarize—Summarizes the current parent-component definitions into 
an array which shows at a glance the relationship of various line items.

Figure 3-24: Component Summary View

When you select the Summarize option from the Options menu, the levels 
are built and a text report is generated and displayed on the ocmco.smry form.

Each element in the summary array corresponds to a component record in 
the model file. 

Each summary line contains:

� The ** designates the item as a Default item (the Default condition for the 
item is set to true on the ocmco format)

� The Description

� The Part No

� The Quantity required for this item
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� Placing the cursor on any element in the list and pressing Enter presents 
a display only summary of the model record for that item, on the 
model.summary format. 

� Clicking Find from within the Part No field displays associated 
modelvendor records.

� Clicking Find within the Part No field from the modelvendor form 
displays the complete associated model record.

Print confg—calls Report Exerciser and displays the report 
ocmco.print.config, which builds the same summary array as in the 
summarize option and prints detailed information on all components in the 
summary.

Figure 3-25: Component Print Configuration

This example shows the Report Maintenance screen describing the 
ocmco.print.config report. The primary query reflects the part that was 
displayed when the print confg option was selected.
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The report itself shows information from the model file for each of the 
components listed in the summary array discussed in the summarize option.

Print detl—calls Report Exerciser and displays the report ocmco.print.detail, 
which builds the same summary array as in the summarize option and prints 
detailed information for the specific component on the current record.

Figure 3-26: Component Print Detail

This example shows the Report Maintenance screen describing the 
ocmco.print.detail report. The report itself shows the detailed information 
from the model record for the part that was displayed when the print detl 
option was selected.

Alternate views of the model file are available when you click Views in the 
tool bar. The following describe what is displayed in the alternate views, such 
as the Catalog (ocmco or ocmo.detail) View on page 91 and Model View on 
page 102. Added options available while in these views is discussed in 
Additional Options on page 112.
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To add information:

Figure 3-27: ocmco.detail View of Record Data

Model View

The model form is an alternate view of the model file. It displays the main part 
specifications and order fields, tied in with the current inventory, and 
provides control over when to reorder this item.

To display the model alternative view of a record while viewing a record:

1 Click Views in the system tray.
102 �Chapter 3—Catalog Operations 



Request Management Guide
2 Double-click the model option to select it from the record list that 
ServiceCenter creates, shown in Figure 3-18 on page 92.

Figure 3-28: Model view of model information

Use the following descriptions of the model form fields to identify the data 
contained and add or modify the data as needed.

Field Description

Part No The unique identifier for this Catalog entry; 
system-generated if not entered by operator when adding the 
record.

Brief Description
(required)

The brief text description used for QBE list.

Manufacturer
(required) 

The manufacturer of this component; validated against the 
vendor file.

Model
(required)

A unique definition for the component, usually defined by 
the manufacturer.
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General Information tab

See the General Information tab shown in Figure 3-28 on page 103.

Model Ext. Displays extension applied to model number for more 
specific identification.

Serialized Designates if this component is serialized or non-serialized, 
that is, to be tracked by individual units by serial number or 
simply by quantities; affects the order generating process and 
the receiving process.

Field Description

Config File The name of the file to which data is posted when this type of 
inventory record is received.

Default Priority A default number to control the order in which items are 
presented for selection from the Catalog when opening a line 
item.

Cost The price tag assigned to or associated with this item when it 
is replaced.

Currency The Currency in which the associated cost is stated.

Default Quantity The default quantity set for this item.

Detailed Desc Text description of the record; copied to the line item 
description in the quote summary and printed on orders and 
reports.

Instructions Any special instructions or information needed for 
completion or assembly of this particular Catalog entry.

Field Description
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Current Quantities tab

Figure 3-29: Current Quantities tab

Total: By Stockroom Area

Field Description

Installed For serialized items, the number of units in the device file listed 
as installed; for non-serialized items, the number of units that 
have been delivered over the life of the item.

Available For serialized items, the number of units in the device file listed 
as available; for non-serialized items, the current on-hand 
quantity.

Reserved For serialized items, the number of units in the device file listed 
as reserved; not used for non-serialized items.

Unavailable The number of units in the device file that are listed as 
unavailable.

Received For both serialized and non-serialized items, the number of units 
currently received--that is, logged during the order line item 
receiving process but not yet posted to the appropriate inventory 
file.

On Order For both serialized and non-serialized items, the number of units 
currently on order.
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Reorder tab

Figure 3-30: Reorder Information tab

On Request For both serialized and non-serialized items, the number of units 
currently on request.

Backordered For both serialized and non-serialized items, the number of units 
currently back ordered.

Field Description

Min Ord Amount The minimum order quantity for this item; if an operator 
requests less than this amount, the requested amount is 
adjusted upward to this amount.

Max Ord Amount The maximum order quantity for this item; if an operator 
requests more than this amount, the requested amount is 
adjusted down to this amount.

Lot Size (Ord) The lot size used when the item is ordered from a vendor; 
the order amount is a multiple of this number, or if not, is 
adjusted accordingly.

Field Description
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Unit/Measure The standard unit of measure for this item (using a validity 
table).

Reorder Type (required) A control field designating the type of processing 
used when an item is ordered. Valid values:

� batch - The Order Generation application 
ocmo.create.order attempts to fill quote line items with 
available inventory (if the Consume Avail? field is 
checked); to order according to a planned time and in 
batches; and is the only way to combine multiple quote 
line items into one order line item for discounts 
advantages.

� immediate - When a quote line item is marked available 
for ordering, an order create record is scheduled for 
immediate processing of that one item.

� phantom - No ordering is performed for a phantom part.

Purchasing Group The purchasing group from which this part is ordered.

Material Group The type of materials (or services) needed, such as office 
supplies, computer supplies, or outside services.

Consume Avail? Designates if available inventory is to be consumed when 
the line items within an order are processed. The default is 
false.

Combine? Designates if the order generation application 
ocmo.create.order combines quote line item quantities into 
one order line item. The default is false, so that a unique 
order and order line item are created for each quote line 
item.

Track Receiving? Designates if the order line item for this component is 
received into the system, with information recorded in the 
receiving log. If false, the line item is closed but not received.

Stockroom Designates a stockroom where this part should be received.

Reorder Point When on-hand inventory drops below this number, the 
quantity shown in the Reorder Amount field is ordered, if 
the Reorder Type field is set to batch.

Reorder Amount The amount ordered when the on-hand inventory drops 
below the value in the Reorder Point field, if the Reorder 
Type field is set to batch.

Field Description
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Vendors tab
The Vendors tab stores specific vendor information for a product.

Figure 3-31: Vendors tab

Field Description

Show All Vendors 
button

Finds all vendors for this item and presents the associated 
modelvendor records, through a Link record performing 
a search on the Part No of this model record.

Add a Vendor button Add a vendor in the modelvendor records. See 
Modelvendor File on page 113 to learn more about filling 
in the modelvendor form.

Vendor Name of vendor.

Unit Cost Total monetary value of this part.

Trans Type Transaction type, such as purchase.

# Payment Number of payments to be made for the cost of the part.

Payment Amt Monetary value to be paid each time a payment is made.
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Catalog tab

Figure 3-32: Catalog Information tab

The Catalog Information tab stores all the information about the inventoried 
parts and items, including: 

� Components - see Components tab on page 93.

� Dependencies - see Dependencies tab on page 94.

� Part Conditions - see Part Conditions tab on page 94.

� Component Conditions - see Component Conditions tab on page 96.

� Approvals/Alerts - see Approvals/Alerts tab on page 97.

� Receiving/Posting - see Receiving/Posting tab on page 97.

Field Description

LI Category The line item category to which this part is associated. Each 
part in the catalog must belong to a line item category (same as 
on model format).
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You can define and control how items/parts are ordered, grouped, approved, 
received, and posted.

Software tab

Figure 3-33 shows the Software tab.

Figure 3-33: Software tab

The Software tab displays information about software, licenses, and 
installation. 

Assigned Dept If requests for this part are always assigned to the same 
department, you can enter that department here.

Sequence Used to sort the list of parts for a specific category.

Note: You can modify the sort order within the Sequence 
field by selecting the category key in the model file. Once 
selected, enter the Category field first, and then enter other 
field names according to the order in which you would like 
the parts sorted.

Field Description

Application Name The name of the licensed software product.

Single User Select if the application is software to be installed on a single 
workstation for a single user.

Field Description
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Picture tab

Figure 3-34 shows the Picture tab.

Figure 3-34: Picture tab

Insert a bitmap into the model record. Right-click on the grey box, select 
Insert bitmap, and browse your directory to locate the bitmap.

Multi-User Select if the software is Client/Server or resides on a file server. 
When you click Multi-User, a list appears. Select Per named 
workstation, Per named user, or Per concurrent accesses, 
which is a limit on the number of licenses in use at any time.

Total Number of 
Installs

If you specified Multi-User, type the number of installations. A 
single-user installation appears as 1.

Evaluation Rights The maximum number of installations for demonstration or 
evaluation purposes.

Points Per Install For certain types of licenses, the number of points each license 
right consumes.

Version Displays the software version number.

Authorized? Checked if this is an authorized version to use.

Field Description
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Relationships

Modelvendor File
The Part No field establishes the relationship between the model and the 
modelvendor files. This relationship is maintained by the 
model.validate.vendor application, called by Format Control Subroutines. 

If the operator:

� changes the Part No, all associated modelvendor records are automatically 
updated.

� deletes a model record, all associated modelvendor records are 
automatically deleted.

� copies an existing model record, a QBE list of associated modelvendor 
records is displayed with the option of copying all or specific records.

Receiving
The Track Receiving? field controls whether the receiving process will occur 
for this part. This is independent from the Serialized field, so items can be 
received without being limited to particular configuration rules. In other 
words, the part does not need to be serialized to be received.

The Serialized field impacts the receiving process in that for each serialized 
item received, such as 3 qty, the serial number for each must be specified 
during receiving, and 3 records are created in the receiving log.

Additional Options
By pulling down the Options menu while viewing a model record (via ocmco, 
ocmco.detail or model form), several additional operator options allow the 
operator additional control of how the data can be presented. 

From the ocmco and model views, the Options menu has the following 
additional controls:

Field Description

Print Send a copy of the record to the default printer.

Validity Lookup Checks the selected field against the ServiceCenter validity 
tables for that field.
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Modelvendor File

The modelvendor file provides relational information between a particular 
part, or model, with an associated vendor(s) for that part. Some of the 
information tracked includes various costs, lead times, and payment 
schedules each vendor offers for a particular item.

To access the file from the main Request Management menu:

1 Click Supporting Files in the Maintenance tab.

2 Click Model Vendors in the Catalog tab. 

Export/Unload Allows you to export this record into a file for importing 
into a spreadsheet, or unload this dataset for loading into 
another ServiceCenter system. Basically, you can export 
information to any product that has DDE (Dynamic Data 
Exchange) support.

IR Query Accesses ServiceCenter’s IR (Information Retrieval) Expert 
application.

Expand Array Add a field to an array (list of elements of the same data type 
accessed by an index or element number). A separate 
window is displayed to enter the data.

Take inventory Runs the model.take.inventory application to search the file 
in Config File field for all items in the inventory with the 
same Part Number and totals based on Status (installed, 
reserved, available, unavailable); then calculates in the ocml 
file the number for on order, on request, and received.

Field Description
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Figure 3-35 shows the modelvendor.g format.

Figure 3-35: Modelvendor Form

Use the following field descriptions to identify field values and contents:

Field Description

Model Vendor No Display only, unique sequential number system-generated for 
each modelvendor record. Copied to the quote line item.

Part No (required) The unique identifier of the item defined in the 
model file that relates to this modelvendor record. This field 
establishes the link between the model and modelvendor 
files, and is validated against the model file.

Manufacturer Displays information from the model file, associated with the 
Part No.

Model Displays information from the model file, associated with the 
Part No.
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Cost Information Area

Payment Information Area

Vendor (required) The name of the organization that provides the 
particular service or product. This field has a link to the 
vendor file, and is validated against that file.

Vendor Part No The part number assigned to this item by this particular 
vendor.

Trans Type (required) The type of service provided by the vendor for this 
item. Valid values: purchase, lease, rental, service, maint.

Field Description

Cost $ The total monetary value charged by the vendor for the service or 
product.

Labor Hours The number of hours required to complete the defined unit of 
work.

Labor $/hr The per hour labor cost.

Otime $/hr The per hour overtime labor cost.

Tax Code Identifies a record in the taxcodes file that contains the actual tax 
rate. This field is copied to the quote line item.

Rate The link on Code populates the Rate field, but the value can be 
modified to override the rate stored in the taxcodes file. This field 
is copied to the quote line item.

Field Description

Payment Freq. The frequency that the vendor expects payment for the 
service or product.

No. of Pmts The total number of times the vendor allows payments of a 
fixed portion of the cost. NULL or zero (0) indicates that the 
balance must be paid in full in one payment.

Payment Amount The cost of each payment, calculated by dividing Cost by No. 
of Pmts. If No. of Pmts is NULL or zero (0), Payment 
Amount equals the Cost.

Field Description
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Ordering Controls tab
See the tab shown in Figure 3-35 on page 114.

Payment Terms The payment terms defined by the vendor.

Bill to Code The location code (from the location file) of where the vendor 
should mail the invoice for the items shipped to your 
organization.

Field Description

Lead Time The number of days advance notice the vendor requires to 
deliver the product or service. Expressed as a date/time 
relative to current date/time and to Duty Table; the default 
is zero (0).

Duty Table The name of the Calendar Duty Table that Lead Time is 
calculated against in order to arrive at a date. If NULL, the 
system calculates Lead Time against a 24/7 time table.

Ship to Code The location code (from the location file) of where the 
vendor should ship goods when receiving orders for this 
particular item.

Ordering Backend If ordering backend services or line items, select the 
vendor to be used for the avail-to-order items.

Shipping Terms A description of the terms that the vendor is requested to 
use when shipping goods to your location.

Vendor Contract No. The contract number between your organization and the 
vendor that establishes a business relationship. Copied to 
the quote line item.

Priority The priority of this vendor record relative to the other 
vendor records for this particular item. Controls the order 
in which vendors are displayed on the vendor QBE list. 
Defaults to 0 (zero) as the first in priority.

Order Category The name of the order category used by the system when 
creating orders due to on-hand replenishment 
requirements. (The Order Category field in the Order 
Processing Schedule record overrides this field.)

Default Vendor The default vendor to be used, if a user is not authorized to 
select a specific vendor.

Field Description
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Warranty tab
A description of any warranties offered by the vendor for this particular item.

Figure 3-36: Warranty tab

Discounts tab
Figure 3-37 shows the Discounts tab.

Figure 3-37: Discounts tab

Field Description

Discounts A description of any special discounts offered by the vendor for 
this particular item.

Disc Expr Discount expressions are the processing statements executed, at 
open time, to apply discount calculations to the line item when an 
order line item is created. (Use variables $model for the current 
model record and $L.file for the current order line item.)
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Vendor File

The vendor file provides contact and services information for a particular 
vendor.

1 Access the file from the main ServiceCenter menu. Click Vendors in the 
Support tab. Figure 3-38 shows the vendor form.

Figure 3-38: Vendor Details form

The contact and services information for that vendor appears on the General, 
Sales, Service, and Location tabs.
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General tab

Figure 3-39: General tab

Use the following field descriptions to identify field values and contents

Field Description

Name Specify the vendor or manufacturer’s name.

Type Specify the type of vendor or manufacturer.

ID Type the vendor or manufacturer’s identification number.

URL Type the web site address for the vendor or manufacturer, such 
as www.peregrine.com.

Hot Line Type the vendor or manufacturer’s customer support center 
telephone number.

Order Contact Specify the name of the vendor or manufacturer order contact.

Phone Type the vendor or manufacturer’s contact telephone number.

Contract No. Specify the contract number for this vendor or manufacturer.

Contract 
Person

Specify the vendor or manufacturer’s contract administrator.

Phone Type the vendor or manufacturer contract administrator’s phone 
number.
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Sales tab

Figure 3-40: Sales tab

Use the following field descriptions to identify field values and contents

Service tab

Figure 3-41: Service tab

Field Description

Sales Manager Specify the sales manager’s name.

Phone Type the sales manager’s telephone number.

Sales Rep Specify the sales representative’s name.

Phone Type the sales representative’s telephone number.

Sales Hours Specify the hours when you can contact the sales representative.
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Use the following field descriptions to identify field values and contents

Location tab

Figure 3-42: Location tab

Field Description

Technician Specify the service technician’s name.

Phone Type the service technician’s telephone number.

Beeper Type the service technician’s pager number.

Hours Specify the hours when you can contact the service technician.

After Hours 
Contact

Specify who is the appropriate contact for after-hours and 
emergency situations.

Phone Type the after-hours and emergency contact’s telephone number.

Manager Specify the service manager’s name.

Phone Type the service manager’s telephone number.

Escalation 
Procedures

Specify what steps to take if service or the response time is 
unsatisfactory.
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Use the following field descriptions to identify field values and contents

Field Description

Address Type the vendor or manufacturer’s address.

Country Select a country from the drop-down list and click the adjacent 
magnifying glass icon to display the complete description of that 
country.

Phone Type the vendor or manufacturer’s telephone number.

FAX Type the vendor or manufacturer’s FAX number.

Email Type the vendor or manufacturer’s email address.

Vendor Check this box if the supplier is a vendor.

Manufacturer Check this box if the supplier is a manufacturer.
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4
 Approvals
The approval process automates and formalizes the evaluation of quotes and 
orders by the appropriate management entities. This process channels the 
risk, cost, and responsibility associated with a request to the proper levels. 

Read this chapter to learn more about Approvals:

� Overview on page 124

� Approval Components on page 124

� Using Approvals on page 127

� Approval Log on page 135

� Approval Groups on page 138

� Setting Up Approvals on page 139

� External Event Operations on page 140
Approvals � 123



ServiceCenter
Overview

An approval requirement is assigned when an item requires a 
decision-maker’s evaluation. These approvals, though encompassing the line 
items and part numbers listed on the quote or order, operate only at the 
quotes and orders level. The status of individual line items may change (for 
example, from requested to ordered), but it is only the quote or order itself 
that is approved or denied. 

Those operators authorized to issue approvals within each area and category 
of requests and orders are listed in the group definition records. See Security 
and Access on page 29 for more information on operator and user profiles 
and group definitions.

Approval Sequence
Approvals can either be approved, retracted, or denied. Pending approvals 
are awaiting action. Approval groups are placed in sequences in the order 
that their approval is required. If groups have the same sequence number, 
their approvals can be made independent of each other. 

When a pending approval is approved, its status becomes approved and the 
quote or order moves on to the next phase. 

Approval Components

The Approval Status of a quote or order remains pending until appropriate 
approval actions have been taken. The following introduces the components 
of the approval process.

� Approval Status

� Approval Files and Features

� Approval Actions

Gen by items are those items which cause an approval to be required. These 
items include individual line items, part numbers, quotes, and orders.
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Although all the record types listed as possible Gen by item can generate 
individual approval requirements, the approval requirements for the line 
items and part numbers are consolidated to the parent quote or order, the 
Control item. The line items and part numbers themselves are not approved, 
but the approvals are done for the control items for the line item or part 
number displayed. Figure 4-1 shows the approval work flow.

Figure 4-1: “Generated By” Control Flow

A series of line items B, C, D and E, for example, may each generate an 
approval requirement (four separate approval requirements— B1, C1, D1 
and E1), thus making each technically a Gen by item. These approval 
requirements are then bundled and attached or assigned to the quote or 
order (Control item) for the line items displayed, which carries its own 
approval requirement (A1). 

When an approval (A2) is given for the Control item approval requirement 
(A1), the approval is also given to each of the line item approval 
requirements (B1, C1, D1 and E1). One approval will approve the whole and 
all of its parts. 

Quote/Order A

Line Item B

Line Item C

Line Item D

Line Item E

Approval Requirement A1

Generates

Generates

Generates

Generates

Controls (Assigned)

Generates

Approval Requirement B1
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Approval Requirement E1

Approval A2Controls
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Approval Status
The Status of a quote or order is the current state of that record, whether it is 
waiting for its items to be ordered or received, but no approvals are required 
for the status to change. A unique status is given to each line item within the 
quote or order, as well as the quote or order as a whole. Some phases require 
approvals, as a phase change most often involves the intervention of a 
decision-maker, indicating the request or order needs to be moved on to 
another department or area’s responsibility.

The approval status of a quote or order reflects the current condition of all 
subordinate approval requirements associated with the Control item. Request 
Management contains the following default approval statuses.

approved—all of the approval requirements have been approved.

denied—the approval requirements have been denied.

pending—active and waiting for an approval action.

Approval Files and Features
Two primary files contain approval information: the Approval Definitions 
(ApprovalDef) and the Approval Log (ApprovalLog).

Approval Definition—defines the approvals used by all phases (static file).

Approval Log —Current Approvals (lists current approval actions).

� Currently, an unlimited number of approval requirements can be defined 
for each item.

� Approvals may have conditions attached, such as Total Cost, Lead, Time 
requirements, and Impact.
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Approval Actions
Approval groups have the following options when facing an approval 
requirement. 

Approve gives authority to proceed with the item or scheduled work, or 
accept completed work. There are four pre-defined approval types:

� All means the record is approved when all members of the approving 
group issue an approval.

� One must approve means the record is approved with one approval from 
any member of the approving group.

� Quorum means the record is approved as soon as a majority of the 
approving group indicate approval.

� All must approve - immediate denial means that all approvers must 
approve the record. The first denial causes the status to change to Deny. 
All approvers do not need to register their approval action.

Deny means there is no authority to proceed with the item or scheduled 
work, or reject completed work. 

� All must approve - immediate denial means that all approvers must 
approve the record. The first denial causes the status to change to Deny. 
All approvers do not need to register their approval action.

Otherwise, the record is denied when all members of the approving group 
issue a denial.

Retract removes a previously approved or denied action. This resets the 
approval status to pending.

Using Approvals

Operator ServiceCenter user profiles will determine whether they see an 
Approve Requests button on the main system home menu after they log on. 
Users with the appropriate approval authority, such as MAX.MANAGER, 
will have access to the Approve Requests button.

Users with the appropriate approval authorities and privileges to the query 
and summary screens can access approvals from within Request 
Management.
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To access approval process:

� If an Approve Requests button is displayed on the ServiceCenter main 
menu, select this button. (MAX.MANAGER login has the approval 
authority, therefore the Approve Requests button is displayed on the 
ServiceCenter home menu.)

� If this button is not displayed on the main menu:

� Select Request Management on the Services tab.

� Open a quote or order, or search existing quotes or orders.

See Access from Quote and Order Search Forms on page 128 for more 
information to continue through the process.

Access from Quote and Order Search Forms
In order to access Approvals from the Search screens, an operator’s Request 
Management profile must meet the following requirements:

� The Approvals parameter for the current area (quote or order) must 
evaluate to true. See Security and Access on page 29 for more information.

� The Approvals Group field must contain at least one group for the current 
Area. See Security and Access on page 29 for more information.

Note: If a user does not have access rights to a particular area or to approval 
records, a message is displayed in the status bar indicating this.

To access Approvals from the Search screens:

1 Click Request Management on the ServiceCenter home menu.

2 From the Quotes or Orders tab, select Search Quotes or Search Orders 
respectively.

3 Click Search to pass a true query without entering any values in the form. A 
record list of quotes or orders appears. Select a record to view.
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4 Figure 4-2 shows the Approvals tab. 

Figure 4-2: Accessing Quote Approvals

The Approvals tab consists of two sub-tabs, including Current Approvals and 
Approval Log. The following definitions identify the fields of the 
ocmq.view.summary form in the Current Approvals tab and Approval Log 
tab.

Current Approvals tab

See the Current Approvals tab shown in Figure 4-2.

Field Description

Approval Type Corresponds to the Approval Definition that defines the 
approval requirements for the record.

Approval Status The Status of the approval requirement.

# Approved Number of approvals issued.

# Denied Number of denials issued.

# Pending Number of requirements pending approval action.
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Approval Log tab

Figure 4-3: Approval Log tab

1 If the user has quotes authority in only one group, the record list of current 
requests appears, as shown in Figure 4-2 on page 129. 

If the user has approval authority for multiple groups, the Approval Group 
Select dialog box shown in Figure 4-4 on page 131 appears. Select the groups 
that you want searched. 

Field Description

Action The action taken by the approver or approval group.

Approver/Operator The approver, approval group, or operator.

By The operator who performed the approval action.

Date/Time The date of the approval action.

Phase The current phase of the quote or order.
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Request Management places a check mark beside the flagged group boxes 
and searches for requests currently awaiting approvals for that group. If all 
groups are checked, all groups are queried.

Figure 4-4: Approval Group Selection

2 Click OK. If only one request is found, that request is displayed. Otherwise, 
the list of current requests is displayed.

3 If the record list displays, click on the number of the request you want to 
view. 

4 From the Request (in the Options menu), the user can select an individual 
quote and execute one of the following actions, based on the quote’s current 
status.

5 Click a quote number to access a quote for action.

Action Description

Approve Gives authority to proceed with all items in list.

Deny Denies authority to proceed with all items in list.

Retract Removes previous approval actions.
Using Approvals � 131



ServiceCenter
6 Click Options > Approval > Approve or Deny to approve or deny the quote. 
Figure 4-5 shows the approval choices.

Figure 4-5: Quote Approval options

Approval Type Group Options
The Approval Type Group options are presented when you select and click 
on an Approval Type group. Select an Approval Type group option for 
currently pending approvals or future approvals.

Group Option Description

Approve One | Deny 
One | Retract One

Ability to approve, deny, or retract a current or future 
approval for this Approval Type group.

Approve Current | 
Deny Current

Ability to approve or deny current approvals for this 
Approval Type group.

Approve All |Deny All | 
Retract All

Ability to approve all, deny all, or retract all approvals for 
this Approval Type group.
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Approval Definitions
The Approval Definition is a static file that defines the approval groups and 
the approval conditions associated with a particular approval group, as well 
as their valid functional area.

An Approval Definition record defines the basics of an approval 
requirement. The approval condition for each requirement can be based on 
any field in the source record, such as cost, category, assignments, or priority.

Accessing Approval Definitions
1 Click Request Management on the ServiceCenter home menu.

2 Click Supporting Files in the Maintenance tab.

3 Click Definitions in the Approvals structure of the Support tab. A blank 
Approval Definition (ApprovalDef) form is opened.

4 Click Search to pass a true query and retrieve a list of all current Approval 
Definition records.

5 From the record list displayed, double-click an Approval Name to select an 
Approval definition. Figure 4-6 shows the selected Approval Definition 
record.

Figure 4-6: Approval Definition Records
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This form displays the unique values for this approval definition record.

Field Description

Name
(required)

Unique name of the Approval definition record.

Approval Condition
(required)

The condition that must evaluate to true before the 
approval requirement is made active. The default is false.

Approval Type Type of approval required for this approval group 
definition.

� All must approve. All members of the group must 
approve the request. 

� One must approve. Only one member must approve the 
request.

� Quorum. A majority of the approval group must 
approve the request.

� All must approve - immediate denial. All approvers 
must approve the record. The first denial causes the 
status to change to Deny. All approvers do not need to 
register their approval action.

Approval Description A text description of the approval requirement.

Group/Oper The list of operators or groups who can take action on this 
approval.

Sequence
(required)

The order that this Approval Requirement is processed in 
relation to other requirements of the Quote/Order. The 
default is 0 (zero).

Condition The condition that must evaluate to true before the 
approval requirement is made active. The default is false.

Note: Any condition that references the current record 
will use the $L.file as the current file variable.

Description A text description of the approval requirement.
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Approval Log

The Approval Log lists all the approval actions performed for an approval 
request.

When a quote, order, or line item is opened, the system determines that 
item’s approval requirements by searching ApprovalDef for those definitions 
that match what appears in the Phase definition (ocmoptions) for the item, or 
in the Catalog definition (ocmco). When the Approval log is run, all currently 
approved items are included in the list.

Accessing Approval Logs
You can access Approval Logs from the Request Management menu.

1 Click Supporting Files in the Maintenance tab.

2 Click Approval Logs in the Approvals structure of the Support tab.

An empty Approval Log form (ApprovalLog) displays.

3 Click Search to pass a true query and retrieve a list of all current approved 
records.
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4 Figure 4-7 shows the record list. Click the name of the record to open it and 
the selected record appears.

Figure 4-7: Approval Log Record List

The following fields define the unique values of this approval log:

Field Description

ID Unique identification number of this approved record.

File Name Unique name of the Approval Group.

Unique Key Unique key to this record.

Category Category associated with this approval record.

Current Phase Current phase of this approval record.

Action Last action taken against the approval requirement: 
approved, denied, or retracted.

Approval Group/Oper ID of the operator who last modified the record.

Date/Time Date and time of the approval.

Operator Operator or Approval Group that performed the approval 
action.
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From a Request Management Record
When using this method to access the Approval Log records, different 
formats are displayed under different conditions. The Approval Log option 
in the Options menu of the Quote or Order Summary screen opens the 
appropriate Approval Log form and record.

1 From the Request Management Quotes tab, click Search Quotes.

2 Pass a true query by clicking Search without entering any data in the form. 
This displays a list of all current quotes.

3 Locate the number of the quote you wish to view, and click to display the 
quote. Figure 4-8 shows the quote details.

Figure 4-8: Request Management Quote Summary form

4 Pull down the Options menu.

Delegate Designated Approver or Approval Group.

Approval Name Name of the Approval definition.

Field Description
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5 Select Logs > Approval Log. If an Approval Log record (ApprovalLog) exists 
for this quote, it is displayed. 

Approval Groups

Figure 4-9: Approval Group Definition

For directions on how to access the Groups form and definitions of the form 
fields, see Viewing Group Records on page 57.

The Approvers array of the Group Definition form displays the list of 
operators who issue approvals for that group. In addition, they can be 
designated to receive messages about system events, involving quotes, orders, 
or line items. 
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Membership in this group is specified by the Members array values. Those 
operators specified in this array can also receive messages when quotes, 
orders, and line items are entered into the system.

To add a name to an array, update the operator record to use a request profile 
that specifies the group is an approval group.

Events/Messages
Messages can be sent to operators when an event occurs in the system. 
Examples of events include opening a quote (request), approval of a request, 
opening a line item, and closing a phase.

Event records are defined in the ocmevents file. These records indicate what 
message will be sent as a result of the specified action. See Alerts, Events, and 
Messages on page 143 for more information on events and messages.

Setting Up Approvals

Setting up approval authorities and requirements involves the components 
explained earlier in the chapter; several Security and Access elements, 
described in Security and Access on page 29; and several Phase definitions and 
Catalog features, described in Catalog Operations on page 61.

� In order for operators to have approval authority in Request Management, 
their operator records must reflect access capability for the functional 
areas of Request Management (for example, Capability Words in the 
operator record must indicate Request Management access, such as 
SysAdmin, OCMAdmin, OCMO). Setting this up is explained in Security 
and Access on page 29.

� Within Request Management, the user must be included in the 
membership of a designated approval group, in the ocmgroups file. See 
Approval Groups on page 138.
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� The user’s authority within Request Management must be defined in the 
designated Request Management profile, ocmprofile record, specified in 
the operator record. This includes:

� A list of the approval groups for which the user(s) of this profile can 
approve.

� Approval capabilities defined on the various check box tabs of the 
ocmprofile form. Setting this up is explained in Security and Access on 
page 29.

� The approval groups for which this user has approval authority must be 
included in the definition of the approval that is required for the request 
or order.

� Approval requirements are defined on the Phase definition Control tab 
(ocmoptions) or Catalog part record Control tab.

� Approval Definition, ApprovalDef, records must be defined according to 
the Phase definition approval group requirements, which means an 
approval definition record must exist for any group defined as the 
approval group of a particular Phase definition. See Approval Definitions 
on page 133. 

External Event Operations

You can use the method described in the ServiceCenter Automate for 
Windows NT and Unix Guide to send events via email. However, as defined 
below, the event can be configured as an open, approval, denial, or any of the 
other accepted events in the system. Use the method described in the above 
guide for manipulating the data and placing it in the eventin table.

ServiceCenter applications have been set up to support incoming events for 
Request Management. The supported events are as follows:

� rmqin - Supports Open, Update, and Close-phase of Quotes

� rmlin - Supports Open, Update, and Close-phase of Line Items

� rmoin - Supports Open, Update, and Close-phase of Orders

With the above events, it is expected that the event will include the following 
initial data elements:

number^operator^action
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Where number is the item to work on, operator is who to work as, and action 
is what to do (open/update/close).

� approval - Supports Approval actions on Quotes (Approve, Deny, and 
Retract).

The following initial data elements will be included in the event listed above:

area^number^group^action^date^operator^comments

Where area is quote (ocmq), order (ocmo), or line (ocml); number is the item 
to work on; group is the Approval group; action is what to do 
(approve/deny/retract); date is date of the transaction; operator is who to 
work as; and comments is any extra information, such as for billing or 
shipping.
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CHAPTER

5
 Alerts, Events, and Messages
Events are system occurrences, triggered by user activity or certain 
conditions, that require additional user action. Examples of events in 
Request Management include open, update, close, and approval (of quotes).

This chapter describes how to set up and manage standard and special events, 
such as messages and alerts, in Request Management.

Read this chapter for information about:

� Overview on page 144

� Alerts on page 144

� Alert Processing on page 146

� Events on page 154

� Messages on page 163

� Background Processing on page 166
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Overview

Events in Request Management can spawn messages to designated parties 
(operators or groups) within the system. For example, messages can indicate 
if a quote (request) has been opened, and set into action the need for a user 
to provide additional interaction, namely providing an approval for the 
quote.

In the event a certain time limit set for accomplishing an approval is not met, 
an alert is triggered. An alert is an optional timed-delayed event, which 
triggers another event to send out a message.

As soon as a request is approved, that action constitutes an event. A message 
is sent by that event indicating the state of the request.

In this way, events, alerts, and messages build the communication chain, 
notifying users of pending quotes and orders and the status of requested 
items throughout their life cycles.

Note: Setting up alerts, events, messages, and approvals requires the 
operation of the ocm background scheduler. The scheduler must be 
included in the system start-up schedule record. See Background 
Processing on page 166 and Generating Orders on page 172 for help in 
setting up these processes.

Alerts

Quotes, orders, and line items progress in phases according to a predefined 
schedule. Alerts monitor the progress of these phases and take action when 
circumstances warrant an automated response, such as when the progression 
is delayed. For example, the late notice alert notifies a designated 
management group that a quote line item(s) is overdue for approval, and 
updates the alert status to include late notice.

The user can define any number of standard or customized alerts for any 
phase, control who is notified for each alert, and control the naming 
convention used for the alert itself.

Alerts support several functions within the system:
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Alert Messaging—alerts trigger events. The event manager generates 
messages to certain designated recipients as a result of an alert, which 
update the original request.

Batch Scheduling—all alerts associated with a phase are scheduled at once 
when the phase opens.

To access Phase Definition Alert controls:

1 Click Request Management on the ServiceCenter home menu.

2 From either the Quotes, Line Items, or Orders tab, select Quote Phases, Line 
Item Phases, or Order Phases.

3 Click Search to perform a true query without entering any values in the blank 
ocmoptions form. A record list of alert records is displayed. Make your 
selection by clicking on a phase name.

4 Select the Alerts tab.

Figure 5-1 shows the Phase Definition Alert controls.

Figure 5-1: Phase Definition Alert Controls

Certain alert controls are specified on the Phase (ocmoptions) record.
Alerts � 145



ServiceCenter
Alert Controls on the Phase record form include:

Reset—sets the status of all current Alert records associated with the current 
quote or order to inactive and marks the last action field as reset. Then, it 
schedules a calculate alert record to recalculate the item’s alerts and restart 
the alerts process.

Reeval—retrieves each Alert associated with the quote or order and performs 
the following processing:

� If current alert status is active, the alert condition is reevaluated and the 
alert is updated to reflect the correct status; processing ends.

� If current status is not active, the Schedule Condition field is reevaluated. 
If this evaluates to true, the following fields are updated:

� Status is set to scheduled.

� Last Action is set to recalc.

� Action Time is set to current date/time.

� Schedule Condition is reevaluated. If true, Alert Time is recalculated and 
Status updated to scheduled. If false, Status is set to not required.

Retain—determines whether alert log records should be held in the 
ocmalertlog file after the associated item (quote, order, line item) has been 
closed.

Alert Processing

There are two primary files used in alert processing:

� Alert Definition (AlertDef)—defines the alerts used by all phases (static 
file).

� Current Alerts (Alerts)—tracks the alerts created for each phase (active 
alert file).

Alert Definitions
The Alert Definition is a static file, which defines the basic alert information 
for each named alert and all general alert definitions.
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To access the Alert Definition File:

1 Click Request Management on the ServiceCenter home menu.

2 Select Supporting Files in the Maintenance tab.

3 From the Request Management Support tab, select Definitions in the Alerts 
structure.

An empty Alert Definition form (AlertDef) is opened.

4 Click Search to pass a true query and display a list of all current Alert 
Definition records.

5 Select a record to view from the list by clicking on the alert name. Figure 5-2 
shows the selected record.

Figure 5-2: Alert Definition Record List with first record displayed
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The following field definitions identify the type of data needed for the record:

Scheduling tab
See the Scheduling tab shown in Figure 5-2 on page 147.

Field Description

Alert Name
(required)

Unique name of the Alert.

Description A text description of the Alert Condition.

Field Description

Alert Status Status of the alert. Current file referenced by $L.file.

Schedule Condition Condition that determines if the Alert is scheduled. The 
default is false.

Schedule Class Classification of the scheduled Alert.

Alert Condition (required) Condition that must evaluate to true before the 
alert is set. If evaluations are false, the alert goes away. The 
default is false.

Calculation Type Calculation method used for setting alert conditions. Use 
one of the following:

� Use field in record + interval
Calc Field—name of the date/time field in the quote or 
order that the interval field value is added to in order to 
determine the alert time. (Request Management uses 
the current date/time to apply the alert interval if this 
field is null in the quote or order data record.)

Calc Interval—(required) relative interval of time that is 
added to the Calc Field time to determine the alert time. 
Can be positive or negative time intervals.

� Use expression to set $L.alert.time
Calc Expression—text expressions parsed into a 
message and presented at alert time.
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Update Info tab

Figure 5-3: Update Info tab

Field Description

Format Control Name of the Format Control record to be processed in 
addition to the regular alert processing, when the Alert 
Condition field evaluates to true.

Triggers Off Always set to false (unchecked). DO NOT change this setting.

Statements Processing statements executed in addition to the regular 
alert processing, when the Alert Condition field evaluates to 
true.

Update Process Update process to be used when setting up alerts.

Notifications Notification process to be used when alerts are processed. See 
Notifications on page 168 for an introduction to 
notifications. See the ServiceCenter System Tailoring Guide, 
Notifications for details about accessing, adding, editing, and 
so forth.
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Parents tab

Figure 5-4: Parents tab

Important: Do not make any changes to the definitions in this tab.

Parent Type Area

The parent type that is defined and reflected in the alert status phase.

Duty Table tab
The Duty Table is the work table that is used to calculate alert times. When 
scheduling alerts, the Alert processor determines which shifts are valid for 
sending alerts.

Figure 5-5: Duty Table tab

Field Description

No parent definitions No parent definitions to be defined.

User Defined � Parent File—unique name of the Parent file.

� Parent Id—unique identification number of the 
parent part.

Use expressions to set 
$L.parent.file and 
$L.parent.id

� Expressions—enter the expressions to set the 
$L.parent.file and $L.parent.id.
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Duty Table Type Area

Alert Log
The Alert log is a file that lists currently scheduled and active alerts.

To access the Alert Log file:

1 Click Request Management in the ServiceCenter home menu.

2 Click Supporting files in the Maintenance tab.

3 From the Request Management Support tab, select Alert Logs in the Alerts 
structure.

An empty Alert Log form (Alertlog) displays.

4 Click Search to retrieve a list of all current Alert Log records. Then click on a 
record in the list.

Field Description

No Duty Table (24x7) Duty Table not defined. Use standard 24x7 clock and 
calendar.

Define a Duty Table Create a new table.

Duty Table User defined Duty Table. Customized to set your office 
group’s working hours.

Lookup a Specific 
Duty Table

Allows standard validity Table Look-Up processing so that 
the Alert processor can determine valid shifts, based on an 
existing Duty Table.

Group Lookup Name Allows standard validity Table Look-Up by name, so that 
you can use another Duty Table in the Table Lookup file.

Group Lookup File Allows standard validity Table Look-Up by file, so that you 
can use another Duty Table in the Table Lookup file.

Group Lookup Field Allows standard validity Table Look-Up by field.

Duty Table Field Uses the definition in the Duty Table field.
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Figure 5-6 shows the selected Alert Log record.

Figure 5-6: Selected record in the Alert Log

The following descriptions identify the data contained in each field:

Field Description

Alert ID Unique identification number of this alert.

File Name Name of the alert file.

Unique Key Unique key to this record.

Category The category associated with this alert.

Current Phase Current phase of this alert.

Alert Status Status of the alert. Current file referenced by $L.file.

Alert Time The date/time the alert condition evaluated to true.

Gen by File Gen by file items are those items which cause an alert to be 
required, including individual line items, part numbers, 
quotes, and orders.

Gen by ID Gen by ID items are those items which cause an alert to be 
required, including individual line items, part numbers, 
quotes, and orders.
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Accessing the Alert Log When Viewing a Quote, Line Item, or 
Order Record

1 Click Request Management on the Services tab of the ServiceCenter home 
menu.

2 From the Quotes, Line Items, or Orders tab, click Quote Queue, Line Item 
Queue, or Order Queue, respectively.

3 Click Search in the sc.manage.ocmq, sc.manage.ocml, or sc.manage.ocmo form 
respectively.

4 Click Search again in the ocmq.search, ocml.search, or ocmo.search form 
respectively to perform a true query and retrieve a list of all current records.

5 Select a record to view by double-clicking on the number. 

For this example the Quote queue is accessed, so the record displays in the 
ocmq.view.summary form.

Note: A QBE list is displayed with the first record only if the Record List 
option in the View menu is selected. Otherwise you make your 
selection from the QBE list and select a record to display that record. 
In this example, the Record List option is checked in the View menu.

6 Pull down the Options menu.

7 Select Alert Log, as shown in Figure 5-7 on page 154.

8 If an alert record has not been defined for this quote or order, you are 
prompted to select an alert for the record. 
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9 Click Back to back out and return to the queue.

Figure 5-7: Selecting the Alert Log Option

Events

Events are system occurrences triggered by the creation or update of quotes, 
orders, and line items, such as opening a quote, approving a quote, or 
changing the dollar amount of an order. Events can be used to trigger special 
processing, such as alerts and messages. When these specific activities occur, 
Request Management sends mail messages to users, as part of the default 
processing. Other customized routines can be executed for particular events.

Several default events are included with Request Management. Others may 
be added, according to your business needs (for example, activities or 
conditions that need to be checked or unique events warranting 
notification).
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When an Alert Condition evaluates to true, Request Management treats it as 
an event, and notifications can then be sent for this alert condition.

Event Controls
� The option to schedule events is on the quote, order, and line item 

environment records (environment.ocmq, .ocmo, or .ocml). See 
Environment Access on page 33 for details on how to access the 
environment records. 

The Schedule Events? field in the Quote Options structure (Figure 2-3 on 
page 33) sets when events are processed for categories and phases.

� If this check box is unchecked (false), events are not scheduled for 
processing or recorded in the message log, msglog file.

� If this check box is checked (true), and Messages/Events? in the phase 
record (ocmoptions) is false, the event is scheduled and recorded in the 
msglog, but no other processing occurs.

� The option for processing messages and events is located on the quote, 
order, and line item Phase definition (ocmoptions) record. See Phases on 
page 75 for details on how to access and create phase definitions.

The Messages/Events field in the Controls tab (see Figure 3-9 on page 79) 
sets the controls that define when events are processed for the particular 
phases named.

� All event names must be defined in the ocmevents file, or no event 
processing can occur (see Request Management Events (ocmevents) File on 
page 155).

� Events are processed when the phase of the quote, order, or line item is 
defined in the Phases field of the ocmevents file. If the Phase field is NULL 
on the ocmevents record, the event is processed for all phases.

� The Exec Cond option in the ocmevents record controls -- at the event 
level -- when an event is processed.

Request Management Events (ocmevents) File
This file contains the names and definitions of all valid Request Management 
events.
Events � 155



ServiceCenter
To access the event definition form:

1 Click Request Management on the Services tab of the ServiceCenter home 
menu.

2 Click Supporting Files on the Maintenance tab.

3 From the Requests Management Support tab, click Events in the Support 
structure.

A blank events definition form (ocmevents) is displayed.

4 Click Search to perform a true query and display the record list of all 
currently defined events.

5 Select a record to view by clicking on the name of the event. Figure 5-8 shows 
the selected event record.

Figure 5-8: Accessing the ocmevents File
156 �Chapter 5—Alerts, Events, and Messages 



Request Management Guide
The following information describes the field definitions in the record:

Field Description

Event
(required)

Name of the event. Must be unique within each area; quote, 
order, or line item.

Area
(required)

The Request Management area for this event: Quotes, 
Orders, Line Items, or All.

Description Brief description of the event.

Exec Cond Conditional field that defines the processing condition for 
this event, which is processed only when this condition 
evaluates to true. The default is false. (The condition for the 
gen order delayed event, however, should always be true.)

Format Name Name of the form used to build the message sent to the 
users. Allows basic information about the record associated 
with the event to be included in the message; otherwise, the 
standard message is sent.

Format Ctrl Name of the Format Control record executed against the 
particular quote, order, or line item data record when the 
event is processed.

Application Name of the RAD application executed when this event is 
processed. If both Format Ctrl and Application contain 
values, the Application field takes priority.

Names Names passed to the RAD application when the event is 
processed. See the ServiceCenter System Tailoring Guide for 
detailed information.

Values Values passed to the RAD application when the event is 
processed. See the ServiceCenter System Tailoring Guide for 
detailed information.

Phases 
(quote/order/line 
item)

Control over which events are valid for which phases within 
each area. If this field is NULL, the event is valid for all 
phases of the area. (The event gen order delayed is not 
affected.)

Operators Login IDs (names) of those operators who should receive a 
copy of the messages sent via this event.

Field Name Input field names from the ocmq, ocmo, or ocml files 
containing either group names, or operator IDs or Full 
Names (depending on the option specified in the 
Environment record).
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Event Names and Definitions
Request Management includes several predefined system events. You can 
define additional events as needed. The following partial QBE list shows 
some of the most commonly used predefined system events, and to which 
Request Management areas they apply.

Commonly Used Predefined System Events
The following table describes predefined system events.

Member List An indication of which list of operators in the ocmgroups 
file should receive mail notification. Valid values include:

� member—each operator in the ocmgroups Members 
array will receive mail notification

� approver—each operator in the ocmgroups Approvers 
array will receive mail notification

� all—operators in both arrays will receive mail 
notification

� operator—this choice is only used if you intend to put an 
individual user ID in the field name.

Append Text The character string added to the generic message that is 
sent as the first line of the message. The message syntax is:

Notice: <type> <number > Phase: <phase name> 
<append.text> <date>

Field Description

Events Area

alerts recalc o (orders)

alerts recalc q (quotes)

alerts reset o

alerts reset q

approval o

approval q

approval reeval o

approval reeval q

approval reset o
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Default List of System Event Names and Definitions
The following is the default list of system event names and definitions. (Some 
apply to certain areas, and others apply to all areas.)

approval reset q

approved o

approved q

close - category change o

close - category change q

close - partial received l (line items)

Event Name Description

alerts recalc The quote/order's alerts have been recalculated.

alerts reset The quote/order's alerts have been reset.

approval An operator has approved one of the approval requirements 
of an item.

approval reeval The approval requirements of a quote/order have been 
reevaluated.

approval reset The approval requirements of a quote/order have been reset.

approved All approval requirements for an item have been approved.

close -

category change

The category of a quote/order has been manually changed.

close -

partially received

A line item has been closed, but not all of the ordered 
quantities have been received.

close -

phase change

The phase of an item has been closed due to a manual phase 
change.

close -- received A line item has been fully received; or, all of the line items of 
an order have been fully received.

close final The final phase of an item is complete. The item is closed.

close phase An intermediary phase of an item is complete, but the item is 
still open.

Events Area
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copy&open An item (quote, order, or line item) has been copied to a new 
item.

denial One of an item’s approval requirements has been denied.

denied The quote/order is denied based on the Approval Status rules.

drop avail A line item has been manually dropped from the available to 
order status.

due date notice This contains sample system data.

gen order delayed The background generate orders process has been delayed 
due to a posting process that has not yet completed. The 
generate orders schedule record has been updated to run at its 
next normally scheduled time.

late notice This contains sample system data.

mark avail A line item has been made available for order processing.

open An item has been opened.

open next The next phase of an item has been opened.

open next- 

category change

A new phase has been started due to a manual category 
change.

open next- 

phase change

The next phase has been started due to a manual phase 
change.

pending vendor - 
select

A line item is pending the selection/assignment of a vendor 
and cannot be processed until the vendor is assigned.

post bg - 

error

The line item that was targeted for posting could not be 
found.

post bg - 

excessive resched

A background posting schedule record has been rescheduled 
more than three times.

post bg - 

process error

During background posting of line item data, an unknown 
processing error occurred.

post bg - 

quote not found

During background posting, the parent quote could not be 
found; no data was posted.

post bg - 

rescheduled

The parent quote/order could not be locked.

posting not 
complete

When quantity > 0, and Received + BO’d + Cancel + 
Returned = 0 (the fields on ocml.receive.post format)

Event Name Description
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Defining Additional Events
A new event can be defined and called by Format Control calculations, in the 
case that a specific condition must be checked for the event to occur at 
specialized times.

The syntax generally used to check for an event is as follows:

(x=o, q, or l): if (condition=true) then ($ocmx.events.pntr in $ocmx.events=“event 
name”;$ocmx.events.pntr+=1)

� The variable $ocmx.events (where x = the area q, o, or l) is an array of 
character strings used to track the events that occur during a particular 
phase of processing. 

� The variable $ocmx.events.pntr is a pointer to the next array element that 
can be used to record an event name. 

reeval For approvals or alerts.

reopen A closed item has been reopened.

reset For approvals and alerts.

shortage The OCM Order Create background processor attempted to 
process a quote line item; there is insufficient available 
inventory to satisfy the requirement of the line item. There 
are no open orders for this Part.

sap order pricing SAP associates and verifies prices for individual items to be 
ordered

sap purchase req SAP processed ServiceCenter request and queries for items 
available to order

sap quote pricing SAP associates prices with items that are displayed on the 
ServiceCenter quote.

unapproval An operator has retracted one of the approval requirements 
of an item.

update An item has been updated.

waiting The OCM Order Create background processor attempted to 
process a quote line item; there is insufficient available 
inventory, but there is already an outstanding order for the 
Part. Waiting on receipt of item.

Event Name Description
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Important: Once an event has been added to the array, it is important to 
increment the pointer by 1 (one). If this does not happen, the 
event previously recorded will be overwritten.

The event that is scheduled if the condition is true must be defined in the 
ocmevents file.

Adding New Events
The following steps are required for adding new events to the system:

1 Activate the OCM Processor (ocm), see Background Processing on page 166 
for more details.

2 Set the environment record Schedule Events? option for the area to true. See 
Environment Access on page 33 for more details.

3 Define the Messages/Events option for the phase. See Phases on page 75 for 
more information.

4 Set any RAD or Format Control definition to track a custom event. See the 
ServiceCenter System Tailoring Guide, Format Control to learn more about the 
Format Control options. See Event Controls on page 155 for more 
information.

5 Define the operator groups in the ocmevents record in the ocmgroups file.

6 Define the appropriate operator records.

7 Define the event in the ocmevents file.

a Define the Exec Cond.

b Define the Format Name in the format file.

c Define any Format Ctrl in the formatctrl file.

d Set any Application to a valid RAD routine with valid parameter names 
and values.

e Define the field names in the Area database dictionary file. See the 
ServiceCenter System Tailoring Guide to learn more about the Database 
Dictionary.

f Validate the member list.

For more information on Format Control operations and customization 
options, see Format Control in the ServiceCenter System Tailoring Guide.
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Messages

Messages are sent in response to an event. They can be directed to specific 
operators listed in the event record and contain values from certain fields in 
quote, order, and line item records, which cause the initial event.

Request Management message processing involves:

� The background processor looking at the ocmoptions record for the phase 
or category that generated the event. If the record does not exist, 
processing ends.

� Evaluation of the Messages/Events option in the ocmoptions record. If 
false, processing ends.

� Checking for Field Name and Operators in the ocmevents record. If none, 
processing ends (unless this event is gen order delayed).

� Recording in the msglog the generic message (from the ocmevents 
record’s Append Text field).

� Sending the standard message and the mail message to the operators 
defined in the Operators field of the ocmevents record.

� Sending a message to the operators defined in those fields referenced by 
the Field Name field of the ocmevents record.

The content of these fields is first assumed to be a group. If this group name 
is found in the ocmgroups file, then either the Members or Approvers 
(depending on the Member List field) of that group are added to a working 
list.

If this group name does not exist, the system searches the operator file; and 
if an operator record is found, it is added to the working list.

� Checking the working list for operators, and sending the message.
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Message Classes
ServiceCenter has several default message classes where a user can define 
additional messages to display in Request Management. 

To display the list of available classes:

1 Click Administration on the Utilities tab of the ServiceCenter home menu.

2 Select the Notifications tab in the Administration menu.

The Message Classes structure contains the buttons for the various message 
classes. The buttons displayed are: On-Screen (msg), Print (print), Log (log), 
TSO (TSO), External E-Mail (email) and Internal E-Mail (email). These 
represent the possible action types for message classes.

A message class record may be entered into multiple message class types.

Viewing a Message Class Record
To view a Message Class record:

1 Click Administration on the Utilities tab in the ServiceCenter home menu.

2 Select the Notifications tab of the Administration menu.

3 Click Log in the Message Classes structure.

4 Enter a Class Name, or click Search to pass a true query and display a current 
class list.

5 Select a record to view from the list, which displays by clicking on the name.

6 View the desired record. Each class message presents a different form 
associated with the msgclass.log file.

Message Class Button Description

On Screen Send a message to the user’s screen.

Print Send a copy of the message to the receiver’s default 
printer.

Log Send a copy of the message to the msglog file.

TSO Send a copy of the message to the receiver’s TSO ID.

External E-Mail Send a copy of the message to the receiver’s e-mail 
address as specified in the operator or contacts record.

Internal E-Mail Send a copy of the message to the receiver’s internal 
ServiceCenter mailbox.
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Adding Message Class Records
1 Click Administration on the Utilities tab. of the ServiceCenter home menu.

2 Select the Notifications tab of the Administration menu.

3 Select an action type from the Message Classes structure (see Message Classes 
on page 164 for a description of each action type).

A blank Message Class File record is displayed.

4 Do one of the following:

� Begin entering the message name and data; Class Name can be the name 
of the particular event.

� Call up the message record, select an existing class record on which to base 
your new record. Make appropriate modifications, including a name 
change.

5 Click Add to confirm the new record shown in Figure 5-9.

Figure 5-9: Sample message in Message Class file
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Background Processing

A great deal of the processing which enables the alerts and updating in 
Request Management occurs in the background. Figure 5-10 shows the 
general event processing flow of the application.

Figure 5-10: Process flow

1) User/System does something/something happens.
2) Events list is appended with an action (something the system

must now do) on open or reset.
3) End of user/system process.
4) Schedule the event process -- schedule the daemon.

5)   For each event in the list:

Look for Message definition/Event
(Event Pool)

Next
Event

Send Message/”Event”

background

Yes

?
No

runtime

Process Format Control  or Application

Process Format Control or Application

Check the condition
on the Alert

Applies?

Yes

No

Process Statements

Schedule “Event”

6)   When the Alert scheduler wakes up:
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The background processor for Request Management event processing and 
ordering is named ocm. This processor only handles schedule records with a 
class of ocm. By default, the processor checks for new records every 
60 seconds.

Viewing the Processor
1 Click Maintenance on the Utilities tab in the ServiceCenter home menu.

2 Click Startup Information in the System tab.

The blank info.startup record form is displayed.

3 Enter ocm.startup in the Type field, and then press Enter or click Search to do 
a narrow search for the ocm.startup record type.

The ocm.startup record appears in the info.startup form shown in 
Figure 5-11. This is the default start-up record for the Request Management 
(ocm) background processor.

Figure 5-11: Request Management Startup Agent Record

4 The Request Management (ocm) background processor should be defined as 
an agent on the default system start-up record (startup).
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The system startup default record lists the background agents, or processors, 
that start up each time ServiceCenter is started. Most are set for 60-second 
wake-up intervals. This list includes despooler, report, alert (for Incident 
Management), change, availability, agent, marquee, lister, linker, event, and 
scautod.

5 To add any of the remaining start-up records to the system startup record, 
enter the start-up record’s information at the bottom of the system start-up 
record’s agent array.

This system startup default record processes records that are in the schedule 
file. The appropriate background agent picks up the schedule record and 
processes it.

Note: Enter sch on a command line at any time to display the schedule file.

Notifications
The Notification Engine is primarily responsible for sending messages that 
are generated by ServiceCenter events, such as opening or closing a quote or 
order. Administrators can edit these messages, add new messages, change the 
conditions under which the messages will be sent out, as well as select who 
will receive the messages. 

The notification file works with the message file to define notifications for 
common system events. Administrators can modify the notification 
arguments that trigger the notification, as well as define who receives the 
notification. 

To open the notifications file:

1 Click the Utilities tab in the ServiceCenter main window. 

2 Click Administration. 

3 Click the Notifications tab.

4 Click Notifications.

The notification form is displayed.
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5 Enter the Notification Definition name in the Name field and press Enter or 
perform a true query by clicking Search to see a list of all notification records 
on your system.

Figure 5-12: Request Management Notification definitions

To learn more about notification records and their definitions, see the 
ServiceCenter System Tailoring Guide, Notification Records.

The following fields are in the notification definition record:

Field Description

Msg Class Message class relates to the application area. For example ocm.

Msg No Message number corresponds to the scmessage.qbe.g file. The 
Message Class, Message Number, and language fields make up 
the unique key for this notification. If you add your own 
message to the message file, the combination of the Msg Class, 
Msg No and Language fields must not exist in the system 
already.
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Arguments Message arguments can range from none to many. The 
arguments correspond to the %S in the message text. If there is 
only one argument, enter the value directly. List multiple 
arguments in an array. For example ({<arg1>,<arg2>, <and so 
on>}). Elements of the array can be string literals or expressions. 
To reference a value in a record, enter: fieldname in $L.file. 
Strings must be enclosed in double quotes.

Condition Enter the condition under which the message should be sent. 
Values can be True, False, or an expression that evaluates to 
either True or False. The default value is True.

Notify Method Specifies the how the message is sent (for example fax, email, 
etc.). This field can also specify the name of a message class.

Recipients Specifies to whom the message should be sent. Enter an 
expression or string literal that references an individual user or 
group name.

Note: The following fields are only necessary if the Recipients field contains a 
group name.

Group File Enter the file that the group name is referencing. Use this field 
with the files ocmgroups, which allow multiple records to be 
created with the same group name.

Group Area Acceptable values for use with the ocmgroups file are: 

All, Quotes, Line Items, and Orders.

Subgroug The Subgroup field further specifies the user list. Values are: 
Members/Reviewers, Approvers and All.

Field Description
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6
 Ordering
An order is an indication to a vendor that an organization wants a service 
performed or a product delivered to a particular destination. The Ordering 
aspect of Request Management is, therefore, particularly useful when 
vendors are included in the business process. Vendors can be internal 
providers of parts and services, as well as external providers of parts and 
services. 

This chapter covers the following areas, which involve order generation and 
control:

� Overview on page 172

� Generating Orders on page 172

� Routing Orders to External Purchase Systems on page 180
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Overview

The best way to access order information is directly from the line item 
records, rather than order records themselves. The line items provide the 
detailed information about the items being ordered, rather than the order 
header fields. More useful query fields (such as Vendor Name or Assignee) 
are displayed through line items for the vendors to access information about 
their work or procurement obligations. 

The benefits of orders when vendors are involved include:

� the ability to track the vendors.

� preparation by service organizations (such as, internal vendors) for 
upcoming work orders.

� simultaneous updating or closing order line items without interfering 
with others’ access of the quotes.

� the use of Purchase Orders.

Generating Orders

Order generation occurs primarily in the background, with several methods 
available for triggering the actual generation. 

Process
The Request Management order generation process allows control over 
several features:

� order frequency

� treatment of on-hand inventory

� combining line items into a common order line item

Locks
Request Management utilizes the concept of locks— the system’s attempt to 
restrict access to records to ensure that multiple users are not applying 
updates to the same record at the same time. Locking is implemented at the 
Control Item level when a quote or order is viewed. When the quote or order 
is locked, all associated items are locked as well, including line items. For this 
reason, processing, such as the movement between and through phases, 
cannot occur while the user is modifying the control item records.
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The system’s background order processing attempts to lock the Control Items 
(parent quotes) of line items being processed or ordered. Therefore, certain 
implementation issues need to be considered. These include:

� scheduling of background order processing

� establishing the use of the Inactivity Timer (for parameters to kill inactive 
users) (See the ServiceCenter System Administrator’s Guide for details 
about the Inactivity Timer.)

Background Processing
The background processor ocm manages Request Management ordering and 
event processing. This processor’s interval is set by default to check every 60 
seconds for ocm schedule records to process.

There are two ocm class schedule records for the ordering process:

� OCM Order Create for Line Item Schedule Record

� also called Background Order Demand 

� (for batch -- demand order processing) executes the rmo.create.order 
application.

� OCM Check Availability

� also called Background Order Check Availability

� (for batch -- anticipated order processing) executes the 
rmo.create.check.avail application.

Viewing the Processor
1 Click Maintenance on the Utilities tab.

2 Click Startup Information from the System tab.

The blank info.startup record form is displayed.

3 Enter ocm.startup.

4 Press Enter.
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Figure 6-1 shows the ocm.startup record. This is the default start-up record 
for the Request Management (ocm) background processor.

Figure 6-1: Request Management Background Schedule Agent

5 The Request Management (ocm) background processor should be defined as 
an agent on the default system startup record (startup).

The system startup default record lists the background agents, or processors, 
that start up each time ServiceCenter is started. This list includes despooler, 
report, alert (for Incident Management), change, availability, agent, marquee, 
lister, linker, event, and scautod. Most are set for 60-second wake-up intervals 
(Wakeup Interval (secs) field). 

6 To add any of the remaining start-up records to the system start-up record, 
enter the start-up record’s information at the bottom of the system start-up 
record’s Agent array.

This system startup record processes records that are in the schedule file. The 
appropriate background agent picks up the schedule record and processes it. 

Note: Enter sch on the command line at any time to display the schedule file.
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Viewing Order Schedule Records
Viewing the schedule.looksee Schedule record:

� also called Background Order Demand 

� (for batch -- demand order processing) executes the rmo.create.order 
application.

� uses the ocmo.schedule.demand form

To view the schedule record:

1 Select the Maintenance tab from the Request Management home menu.

2 Click Administration.

3 Click Order Create Schedule on the Orders tab.

A blank ocmo.schedule.demand form is displayed.

4 Click Search from the system tray to retrieve any ocm schedule records. There 
is only one schedule record, OCM Create Order, shown in Figure 6-2.

Figure 6-2: Background Order Schedule Record with Line Item Query
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Important: If this record does not display, enter create default in the Name 
field, then click Add. The record is created and saved to the 
system.

OCM Check Availability Schedule Record
� also called Background Order Check Availability

� (for batch -- anticipated order processing) executes the 
rmo.create.check.avail application.

� uses the ocmo.schedule.check.avail form

Processing Control Records

Line Item Query—if entered, the query will override the default query 
executed against the ocml file:

avail.to.order=true and reorder.type=“b” and 
open=true and quantity.balance>0 and target.order<=tod()

Order Category—if entered, the order category used when the new order is 
created overrides the default order category, that is, the order category 
associated with the line item as defined in the modelvendor record.

To view a schedule record:

1 Select the Maintenance tab from the Request Management home menu.

2 Click Administration.

3 Click Check Available Schedule in the Orders tab.

A blank ocmo.schedule.check.avail form is displayed.

4 Click Search from the system tray to retrieve any ocmo schedule records.
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There may not be any at this time. The schedule record shown in Figure 6-3), 
OCM Check Availability, is an example. 

Figure 6-3: Order Availability Check Record

Important: If the record is blank, click Add to save the new record to the 
system.
Generating Orders � 177



ServiceCenter
Methods
The following order-generation methods are supported by Request 
Management. Enter a method in the Processing Model Qry field.

� Batch: immediate—as soon as a line item with a reorder type of immediate 
is marked available to be ordered, a schedule record is created that will 
create an order for the line item. The order created has one line item that 
corresponds to the quote line item (one to one). It is ordered regardless of 
the planned order date. When the order line items are closed, the 
corresponding quote line items are closed. This is especially useful for 
work or service line items or high priority items.

� Batch: demand—this type of ordering gathers all line items that have been 
marked ready for ordering, are batch reorder types, and the planned order 
date has passed. The orders created use the high and low breaks, as set in 
the schedule record. Each order line item may have several quote line 
items that have been combined to allow for bulk purchases. When the 
order line items are closed, the corresponding quote line items are closed.

� Batch: anticipated—this type of ordering is a scheduled process, which 
goes through the model file, looking for catalog items that are batch 
reorder types. The reorder amount>0, and the reorder point is greater 
than the available + on order + backordered. This process creates orders 
for the specific parts.

� Manual: physical—the ability to create an order manually. This is similar 
to creating a quote with line items, but instead of a quote it’s an order with 
line items.

� Manual: gen orders option—the ability to generate an order directly from 
a quote, through an option in the Options menu. This option creates a 
background process schedule record to create an order for each quote line 
item that is marked available to be ordered, one order for each line item.

Batch Ordering
Batch ordering is controlled by the demand schedule records. There can be 
more than one of these demand schedule records in the schedule file at one 
time, to be processed at different intervals and executing different queries.

These schedule records determine when and how often to generate orders.
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They also define what field values cause a break to a new order, as quotes are 
processed. The options here include values found in the vendor, 
vendor.contract.no, trans.type, bill.to.code, ship.to.code, shipping.terms, 
tax.rate, payment.terms, payment.freq, and no.of.payments fields.

Determining what causes a break to a new order line item is also contained 
in the demand schedule records. The options include values from the 
part.no, unit.cost, unit.of.measure, and discount fields.

Processing Control Fields
To view a schedule record:

1 Select the Maintenance tab from the Request Management home menu.

2 Click Administration.

3 Click Check Available Schedule in the Orders tab.

A blank ocmo.schedule.check.avail form is displayed.

4 Click Search from the system tray to retrieve any ocmo schedule records.

Processing Control records (see Figure 6-2 on page 175):

Line Item Query—if entered, the query will override the default query 
executed against the ocml file:

avail.to.order=true and reorder.type=“b” and 
open=true and quantity.balance>0 and target.order<=tod()

Order Category—if entered, the order category used when the new order is 
created overrides the default order category, that is, the order category 
associated with the line item as defined in the modelvendor record.

Order Breaks and Line Item Breaks
To tailor an implementation’s order processing, the Order Breaks and Line 
Item Breaks array fields on this Demand schedule record allow listing of field 
names in a sequence that must coincide with a key in the ocml Database 
Dictionary record. The system checks these field names for differences, as 
each record is processed, to control when to complete the current order or 
line item and start a new one (for example, when to “break”).
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Important: In the base system’s ocml Database Dictionary record, there is a 
key containing the following five fields: avail.to.order, 
reorder.type, open, quantity.balance, and target.order. Do not 
modify this key.

OCM Order Create for Line Item Schedule Record:

� also called Background Order Demand 

� (for batch -- demand order processing) executes the ocmo.create.order 
application.

� uses high breaks for Order Breaks (for example, creates new order record)

� uses low breaks for Line Item Breaks (for example, creates a new line item 
entry within current order).

� will automatically use the “backend” field as the first high break. This field 
is used when certain orders are sent to an external system.

Routing Orders to External Purchase Systems

The processing for orders is the same as for quotes (for example, an order can 
have approvals, alerts, associated events and messages defined).

Specifically for orders, certain possibilities are available for interfacing with 
external systems:

� Email notifications can be sent as usual.

� In Format Control, an eventout record could be created (see the 
ServiceCenter System Tailoring Guide, Format Control). 

� If batch processing is used, the order can be printed to a specific printer. 
(Note that printing of the immediate ordering type is not supported.)

� Alternatively, a file unload process could be performed for recently 
created orders, and the file moved to an external procurement system with 
receipt information fed back into ServiceCenter.
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Prepare for Background Ordering Requirement
Request Management may be set up to automatically send orders to an 
external system. So with the Background ordering of events and line items 
requirements in place, those items become ready for ordering (avail-to-order 
items). Orders that are created with an external backend defined will be 
routed to the external system, according to the ocmbackend definition for 
that event.

Line items are defined as ready to order on the ocml.view.default form.

To create a Background Event (ocmbackend) record:

1 Select the Maintenance tab from the Request Management home menu.

2 Click Administration.

3 Click Backend Order Destinations on the Orders tab.

4 Begin entering the appropriate values for the backend event, based on the 
field definitions below.

-or-
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Click Search from the system tray to bring up a list of existing backend event 
records. Figure 6-4 shows an ocmbackend form.

Figure 6-4: Adding a new Backend Event

a Choose an event you would like to base your new backend event 
configuration on, and open it by clicking the name.

b Enter a new backend event Name.

c Begin additional modifications to the record to create your new backend 
event configuration record. See the field definitions below.

Field Description

Name
(required)

Unique name for this Backend Order event.

Description A short description of this event item (no more than 30 
characters in length).

Create Order Event Creates a Backend Order event, based on what 
information should be sent every time an order is placed.

Create Line Item Event Creates a Backend Line Item event, based on what 
information should be sent every time a line item part is 
ordered.
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5 When you have completed setting up the values for this new event, click Add 
to add it to the ocmbackend file.

Access ocml.view.default Line Item View

The ocml.view.default Line Item view form displays the ordering controls 
that were set in the Catalog for the part and copied over to the line item 
during the request process (see Catalog Operations on page 61). 

1 Select the Line Item tab from the Request Management home menu.

2 Click Line Item Queue.

A blank screen (sc.manage.ocml form) is displayed.

3 Click Search to bring up a blank ocml.search form.

4 Pass a true query by clicking Search without entering any values into the 
fields, or enter any information you know about a line item order record 
value in the form and press Enter to call a specific line item category record. 

A list is displayed along with the first item in the list.

5 Select a line item record from the displayed queue of current items by 
clicking on the number.

Update Order Event Updates will be applied to the order, according to the 
fields noted in the When which fields change? field 
(below) for Backend Order events.

When which fields 
change?

Indicates which of the order’s fields should change when 
the Backend Order event is sent.

Update Lineitem Event Updates will be applied to the line items, according to the 
fields noted in the When which fields change? field 
(below) for Line Item events.

When which fields 
change?

Indicates which of the Line Item fields should change 
when the Backend Line Item event is sent.

Field Description
Routing Orders to External Purchase Systems � 183



ServiceCenter
Figure 6-5 shows the selected line item record in the ocml.view.default form.

Figure 6-5: Order Line Item summary

To see different views of the data, select Views in the system tray and select a 
different view from the menu.
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7
 Closing and Receiving
Once a quote has been officially entered into the system, approvals made, and 
the associated orders generated, the order process moves into a receiving 
mode and closes the individual line items. 

This chapter discusses the following topics in regards to closing and receiving 
ordered and requested items:

� Overview on page 186

� Closing/Receiving Order Line Items on page 186

� Posting on page 191
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Overview

This part of the process begins with the receiving and closing of individual 
order line items. These line items, which make up the larger orders, are then 
traced back to the initiating quote, which can then be closed itself when all 
items (parts and services) have been received/closed. Along this route, there 
are several automatic and manual procedures, which track and associate 
related processes.

Closing/Receiving Order Line Items

Although the workflow of request processing through Request Management 
can be considered the front-end component to be interfaced with an external 
purchasing system, Request Management does receive against the orders 
within the system.

If you use an external purchasing system, the recommendation is to record 
the other system’s Purchase Order Numbers (usually found on packing slip 
information) on the order in Request Management. This involves creating a 
field on the quote and/or order line item formats associated with the ocml 
file. Remember to add the field to the dbDict as well (see the ServiceCenter 
System Tailoring Guide for information about adding fields to the dbDict). 
Then the actual order generated through the external purchasing system can 
be tracked and associated with the original quote, or request, in 
ServiceCenter.

Note: If you order items through Get.It! Resources, you do not need to 
receive in ServiceCenter.

� Order line items for services are closed after the work is completed. 

� Order line items for parts marked in the Catalog for receipt are received -- 
these parts can be serialized or non-serialized (for example, distinguished 
by a unique serial number or not).

After receiving parts representing order line items that may have been 
combined from several different quote line items, a distribution screen is 
presented by default to post the receipt information back to the quote line 
items that generated the order.

After the user completes the receiving and posting process for an order line 
item, the system can be set to automatically close the original quote line item.
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Close Process
1 Select the Orders tab from the Request Management menu.

2 Do one of the following:

� If you know the number of the order you wish to retrieve, click Search 
Orders and enter the number of the order you want. Click Search again.

� If you do not know the order number:

� Click Order Queue on the Orders tab to bring up the order record list. 

� A record list, including all line items which have been grouped in each 
order, will display. 

� Select a record to open and double-click on the number.

� The order record appears, including all line items which have been 
grouped into this order. Double-click the order number you would like 
to view.

3 To view one of the line items, click the numbered button (Line Number 
button) beside the status and other item information in the Order Summary 
tab.
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Figure 7-1 shows the selected order line item record. 

Figure 7-1: Sample Order Line Item summary

� A part line item record will display a Receive button.

� A service line item record will display a Close button.

4 Click Receive or Close to achieve the following:

� Update the current phase of the order.

� Close the order line item with a status of closed.

� Close the originating quote line item.

For this example, click Receive and then click OK.

Note: Scripts can be used during the close process for the operator to provide 
further comments about the work performed. The name of the Close 
Script is displayed on the line item’s phase definition.

When you click Receive, the default receiving screen (ocmlrec.receive) shown 
in Figure 7-2 appears. A different receiving format can be designated on the 
line item category phase definition for the part selected from the catalog.
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Receipt Verification

Figure 7-2: Sample Line Item Receipt Verification

The receiving process:

� Logs the receipt of serialized equipment.

� The Catalog indicates whether an item is to be received and whether it 
is serialized.

� If an item is serialized, it must:

� be Received

� have a quantity of 1

� have a Serial No.

� Posts data to the model record.

� Distributes (posts) the received quantities to the original quote line items.
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Confirmation
When you click OK to confirm receiving/distribution (see Receipt 
Verification on page 189), a distribution confirmation screen can be 
presented, according to your business rules and the user profiles. Users must 
provide confirmation for the process to complete, terminate, or reset. 
Depending on the site’s process flow, receiving personnel may or may not be 
able to provide this information.

By default, the system assigns the receipt to the first line items possible.

Figure 7-3: Confirmation of Receipt

Confirmation options

Option Description

Post Creates schedule records to post the indicated quantities to 
original quote line items in a background process. The process 
waits until the targeted record is released (not locked or in use 
by another user) before posting is completed.

Override Bypasses the cross-checking for line item totals that occurs after 
the Post selection; forces the system to accept the quantities as 
entered, even if cross-checking issues an error message.

Redistribute Sets quantities back to original distribution.
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� If there are any dependent line items ready for ordering, the system marks 
them accordingly.

� If there are no further line items to be ordered, the order goes to the next 
phase.

� If there is no next phase, the order is closed.

Receiving Log
The receiving log tracks the receipt of serialized and non-serialized 
equipment. The system populates this file after the receiving process.

A benefit of the receiving log (ocmlrec) record is that it provides the serial 
number of the particular item or device for posting to the inventory.

To access the log:

1 Select the Maintenance tab from the Request Management menu.

2 Click Administration.

3 From the Line Items tab, click Receiving Log.

Format Control and Link Records

The Format Control record for the ocmlrec form updates the receiving log. 
This Format Control record can be tailored to implement the posting 
process. See the ServiceCenter System Tailoring Guide to learn more about 
Format Control settings.

The link record ocml.receive.copy copies data from the line item to the 
receiving log. This link record (and the ocmlrec database dictionary record) 
can be modified to track additional data fields. See the ServiceCenter System 
Tailoring Guide to learn more about linking records.

Posting

Posting is the process of copying data from a source record to a target record. 
The purpose of posting is to update similar fields in other records without 
having to open those records to modify each field.

A link record defined to support the posting process copies data from orders 
(source records) to quotes (target records). Its Comment field(s) must start 
with the word POST.
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1 Click Tools in the Utilities tab in the system administrator’s home menu.

The Tools menu is displayed.

2 Click Links.

3 Enter the name of the Link record you wish to create in the Form field of the 
Link Manager dialogue box.

4 Click New.

5 Enter the following values in the first line of the new Link record:

Important: You must enter POST in upper case letters in the Comment field 
for the Posting process to work.

Figure 7-4 shows the new Link record.

Figure 7-4: Posting Link Record

Field Value

Source Field Name requested.by

Format/File Name contacts

Target Field Name contact.name

Comments POST
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Posting to a new inventory record is done automatically for all models that 
have a configuration file defined. However, further posting of actions may 
occur, but these require tailoring to the system.

If the background posting process cannot lock records, the posting is 
rescheduled for a certain time in the future (for a maximum number of 
times). If the risk of two users accessing and modifying a record 
simultaneously is unacceptable, other alternatives should be considered for 
posting to records that need to be locked.

The process of posting is covered in the Format Control section of the 
ServiceCenter System Tailoring Guide. In Request Management, the master 
Format Control records (ocmq, ocmo, or ocml) execute first; then the category 
Format Control (name=phase definition’s default view). These Format 
Control records can call the post.fc application.
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8
 Request Management Event Services
Increasingly, enterprise-wide network management tools depend on 
automation to detect activity on the network and to execute the appropriate 
procedures. These network incidents are often called alarms or alerts; 
ServiceCenter refers to them as events.

This chapter discusses the following topics:

� Overview on page 196

� External Event Services on page 196

� Logical Actions on page 197

� Accessing Event Services on page 199

� Quote Events on page 201

� Order Events on page 204

� Line Item Events on page 206
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Overview

ServiceCenter includes Event Services enhancements in Request 
Management to support external event processing. To modify the Event 
Services enhancements, see the ServiceCenter Event Services Guide for detailed 
information.

External Event Services

The External Event Services enhancements include the following events.

Area Action Description

Quote Approve Approve a quote

Quote Deny Deny a quote

Quote Retract Retract a quote

Quote Open Create a new quote

Quote Update Update an existing quote

Quote Close Close current phase and goto next if exists

Order Approve Approve an order

Order Deny Deny an order

Order Retract Retract an order

Order Open Create a new order

Order Update Update an existing order

Order Close Close current phase and goto next if exists

Line Item Open Create a new line item

Line Item Update Update an existing line item

Line Item Close Close current phase and go to next, if exists
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Logical Actions

There are 12 logical actions that are executed via four actual event classes.

Approval Classes
Approval classes are used to send approval actions into Request 
Management. The structure of their event strings is as follows:

Event Class Description

rmlin Used for open/update/close of all line items

rmoin Used for open/update/close of orders

rmqin Used for open/update/close of quotes

approval Used to approve quotes and orders.

Sequence Description

1 File name of the object to be acted upon. 

ocmq = quotes

ocmo = orders

2 Number of the object to be acted upon.

3 Group for which the operator has rights to approve orders. If left 
blank, operator has rights to all groups.

4 Action taken, indicating whether approve, retract, or deny. 

5 Date and time approval was sent.

Mapped data fields containing changes to the record.

Processed along with the approval.

6 Identification of the operator who is executing this approval. The 
approval happens in this operator’s security context.
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Record Modification Classes (rmlin, rmqin, rmoin)
These three events (rmlin, rmqin, rmoin) are used to send record 
modification actions into Request Management for line items, quotes, and 
orders. The structure of their event strings is as follows:

Example Event String Start Sequences (Ignores Data Fields)
See Accessing Event Services on page 199 to access Event Services.

To approve a quote (such as, number Q1234), acting as FALCON, within the 
security group management: 

� Send an Approval event with this string:

ocmq^Q1234^^approve^02/20/01 06:00^FALCON^ok

To update a line item (such as, L78), acting as BOB.HELPDESK:

� Send an rmlin event with this string:

L78^BOB.HELPDESK^update^…………

To move an order (such as, O89) to its next phase, acting as 
MAX.MANAGER:

� Send an rmoin event with this string

O89^MAX.MANAGER^close^………..

Sequence Description

1 Number of the object to be acted upon. If in rmlin, this will be a line 
item number. If in rmqin, this will be a quote number. If in rmoin, 
this will be an order number. In the open process, this field is 
discarded.

2 Operator ID who is executing this action. The action takes place 
within this operator's security context.

3 Action Token, indicating what type of modification action to take. 
One of open, update, close.

4..n Mapped data fields, containing changes to the record. Processed 
along with the approval.
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Accessing Event Services

Windows Client
To access Event Services:

1 Log on to ServiceCenter. 

Note: You must be a ServiceCenter system administrator to work in Event 
Services. 

For detailed information about accessing Event Services, see the 
ServiceCenter Event Services Guide.

2 Select the Utilities tab on the ServiceCenter main menu, as shown in 
Figure 8-1. 

Figure 8-1: Utilities tab in the system administrator’s home menu

3 Click Event Services.
Accessing Event Services � 199



ServiceCenter
Figure 8-2 shows the Event Services menu.

Figure 8-2: Event Services Main Menu

4 Click the Queues tab.

Queues tab
Figure 8-3 shows the Queues tab.

Figure 8-3: Queues tab
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Quote Events

The following table describes quote events.

Button Action

Input Events Opens the eventin file for review. This file contains all events 
awaiting action by ServiceCenter and those that have been 
processed but not deleted.

Output Events Opens the eventout file for review. This file contains all 
ServiceCenter events awaiting action by an external 
application and those that have been processed but not 
deleted.

Map Name Sequence Position File Name Field

rmq 1 1 ocmq number

rmq 1 2 ocmq $L.void.operator

rmq 1 3 ocmq $L.void.action

rmq 1 4 ocmq open

rmq 1 5 ocmq page

rmq 1 6 ocmq category

rmq 1 7 ocmq current.phase

rmq 1 8 ocmq phase.num

rmq 1 9 ocmq phase.start.date

rmq 1 10 ocmq orig.operator

rmq 1 11 ocmq last.operator

rmq 1 12 ocmq impact

rmq 1 13 ocmq total.line.items

rmq 1 14 ocmq alert

rmq 1 15 ocmq alert.names

rmq 1 16 ocmq approval.status

rmq 1 17 ocmq pending.groups
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rmq 1 18 ocmq status

rmq 1 19 ocmq priority

rmq 1 20 ocmq reason

rmq 1 21 ocmq business.area

rmq 1 22 ocmq submit.date

rmq 1 23 ocmq update.date

rmq 1 24 ocmq close.date

rmq 1 25 ocmq cancelled.date

rmq 1 26 ocmq requestor.name

rmq 1 27 ocmq requestor.dept

rmq 1 28 ocmq coordinator

rmq 1 29 ocmq coord.dept

rmq 1 30 ocmq assigned.to

rmq 1 31 ocmq assigned.dept

rmq 1 32 ocmq description

rmq 1 33 ocmq justification

rmq 1 34 ocmq comments

rmq 1 35 ocmq ship.to.code

rmq 1 36 ocmq bill.to.code

rmq 1 37 ocmq shipping.terms

rmq 1 38 ocmq total.cost

rmq 1 39 ocmq completion.code

rmq 1 40 ocmq completion.notes

rmq 1 41 ocmq li.mark.flag

rmq 1 42 ocmq bill.to.ext

rmq 1 43 ocmq ship.to.ext

rmq 1 44 ocmq phase.desc

rmq 1 45 ocmq project.id

rmq 1 46 ocmq orig.manager.group

Map Name Sequence Position File Name Field
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rmq 1 47 ocmq requested.date

rmq 1 48 ocmq admin.lead.time

rmq 1 49 ocmq duty.table

rmq 1 50 ocmq parts.summary

rmq 1 51 ocmq foreign.id

rmq 1 52 ocmq requestor.phone

rmq 1 53 ocmq manager

rmq 1 54 ocmq logical.name

Map Name Sequence Position File Name Field
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Order Events

Map Name Sequence Position File Name Field

rmo 1 1 ocmo number

rmo 1 2 ocmo $L.void.operator

rmo 1 3 ocmo $L.void.action

rmo 1 4 ocmo open

rmo 1 5 ocmo page

rmo 1 6 ocmo category

rmo 1 7 ocmo current.phase

rmo 1 8 ocmo phase.num

rmo 1 9 ocmo phase.start.date

rmo 1 10 ocmo orig.operator

rmo 1 11 ocmo last.operator

rmo 1 12 ocmo impact

rmo 1 13 ocmo total.line.items

rmo 1 14 ocmo vendor

rmo 1 15 ocmo alert

rmo 1 16 ocmo alert.names

rmo 1 17 ocmo approval.status

rmo 1 18 ocmo pending.groups

rmo 1 19 ocmo status

rmo 1 20 ocmo priority

rmo 1 21 ocmo reason

rmo 1 22 ocmo business.area

rmo 1 23 ocmo submit.date

rmo 1 24 ocmo update.date

rmo 1 25 ocmo close.date

rmo 1 26 ocmo coordinator

rmo 1 27 ocmo coord.dept
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rmo 1 28 ocmo total

rmo 1 29 ocmo description

rmo 1 30 ocmo justification

rmo 1 31 ocmo comments

rmo 1 32 ocmo invoice.no

rmo 1 33 ocmo vendor.contact

rmo 1 34 ocmo shipping.terms

rmo 1 35 ocmo po.number

rmo 1 36 ocmo completion.code

rmo 1 37 ocmo completion.notes

rmo 1 38 ocmo net.total

rmo 1 39 ocmo tax.code

rmo 1 40 ocmo tax.rate

rmo 1 41 ocmo tax.amount

rmo 1 42 ocmo ship.to.code

rmo 1 43 ocmo vendor.zip

rmo 1 44 ocmo bill.to.code

rmo 1 45 ocmo shipping.carrier

rmo 1 46 ocmo freight.on.board

rmo 1 47 ocmo payment.terms

rmo 1 48 ocmo freight.charges

rmo 1 49 ocmo vendor.contract.no

rmo 1 50 ocmo discount.rate

rmo 1 51 ocmo discount.amt

rmo 1 52 ocmo ship.to.ext

rmo 1 53 ocmo bill.to.ext

rmo 1 54 ocmo phase.desc

rmo 1 55 ocmo project.id

rmo 1 56 ocmo target.date

Map Name Sequence Position File Name Field
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rmo 1 57 ocmo shipping.terms

rmo 1 58 ocmo orig.manager.group

rmo 1 59 ocmo parts.summary

rmo 1 60 ocmo foreign.id

Map Name Sequence Position File Name Field

rml 1 1 ocml number

rml 1 2 ocml $L.void.operator

rml 1 3 ocml $L.void.action

rml 1 4 ocml page

rml 1 5 ocml phase.num

rml 1 6 ocml phase.desc

rml 1 7 ocml category

rml 1 8 ocml current.phase

rml 1 9 ocml status

rml 1 10 ocml parent.quote

rml 1 11 ocml parent.order

rml 1 12 ocml parent.line.item

rml 1 13 ocml gen.ord.li

rml 1 14 ocml project.id

rml 1 15 ocml alert

rml 1 16 ocml alert.names

rml 1 17 ocml orig.operator

rml 1 18 ocml last.operator

rml 1 19 ocml trans.type

rml 1 20 ocml open

rml 1 21 ocml avail.to.order

Map Name Sequence Position File Name Field
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rml 1 22 ocml business.area

rml 1 23 ocml receiving.priority

rml 1 24 ocml track.receiving

rml 1 25 ocml consolidate

rml 1 26 ocml combine

rml 1 27 ocml deffered.select

rml 1 28 ocml generate.order

rml 1 29 ocml serialized

rml 1 30 ocml reorder.type

rml 1 31 ocml submit.date

rml 1 32 ocml phase.start.date

rml 1 33 ocml update.date

rml 1 34 ocml close.date

rml 1 35 ocml ordered.date

rml 1 36 ocml received.date

rml 1 37 ocml returned.date

rml 1 38 ocml backorder.date

rml 1 39 ocml cancelled.date

rml 1 40 ocml requested.date

rml 1 41 ocml projected.date

rml 1 42 ocml target.date

rml 1 43 ocml actual.date

rml 1 44 ocml requested.lead.time

rml 1 45 ocml target.lead.time

rml 1 46 ocml normal.lead.time

rml 1 47 ocml actual.lead.time

rml 1 48 ocml duty.table

rml 1 49 ocml coordinator

rml 1 50 ocml coord.dept

Map Name Sequence Position File Name Field
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rml 1 51 ocml assigned.to

rml 1 52 ocml assigned.dept

rml 1 53 ocml quantity

rml 1 54 ocml quantity.returned

rml 1 55 ocml quantity.received

rml 1 56 ocml quantity.bo

rml 1 57 ocml quantity.cancelled

rml 1 58 ocml quantity.balance

rml 1 59 ocml from.stock

rml 1 60 ocml description

rml 1 61 ocml comments

rml 1 62 ocml ship.to.code

rml 1 63 ocml ship.to.ext

rml 1 64 ocml bill.to.code

rml 1 65 ocml bill.to.ext

rml 1 66 ocml serial.no.

rml 1 67 ocml shipping.terms

rml 1 68 ocml completion.code

rml 1 69 ocml completion.notes

rml 1 70 ocml part.no

rml 1 71 ocml part.desc

rml 1 72 ocml manufacturer

rml 1 73 ocml model

rml 1 74 ocml model.ext

rml 1 75 ocml unit.of.measure

rml 1 76 ocml level

rml 1 77 ocml sequence

rml 1 78 ocml neg.level

rml 1 79 ocml neg.seq

Map Name Sequence Position File Name Field
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rml 1 80 ocml unit.cost

rml 1 81 ocml labor.hours

rml 1 82 ocml labor.cost

rml 1 83 ocml labor.overtime.hours

rml 1 84 ocml labor.overtime.cost

rml 1 85 ocml tax.code

rml 1 86 ocml tax.rate

rml 1 87 ocml tax.amount

rml 1 88 ocml modelv.no

rml 1 89 ocml vendor

rml 1 90 ocml vendor.part.no

rml 1 91 ocml vendor.contract.no

rml 1 92 ocml vendor.contact

rml 1 93 ocml vendor.dt

rml 1 94 ocml payment.freq

rml 1 95 ocml payment.terms

rml 1 96 ocml no.of.payments

rml 1 97 ocml payment.amount

rml 1 98 ocml discount

rml 1 99 ocml discount.amt

rml 1 100 ocml total

rml 1 101 ocml warehouse

rml 1 102 ocml logical.name

rml 1 103 ocml rma.no

rml 1 104 ocml asset.no

rml 1 105 ocml current.location

rml 1 106 ocml warranty

rml 1 107 ocml request.number

rml 1 108 ocml cm3.access

Map Name Sequence Position File Name Field
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rml 1 109 ocml target.completion

rml 1 110 ocml target.order

rml 1 111 ocml actual.order.lead

rml 1 112 ocml foreign.id

rml 1 113 ocml contact.name

rml 1 114 ocml location

rml 1 115 ocml license.number

Map Name Sequence Position File Name Field
210 �Chapter 8—Request Management Event Services 



APPENDIX

A
 Pre-Implementation Planning
This appendix provides a synopsis of planning considerations for 
implementation of a Request Management system. It should be considered a 
foundation tool for initial planning, to be detailed in conjunction with 
technical consulting services.

This appendix covers the following topics:

� The Catalog on page 212

� Structure of the Catalog on page 213

� Building the Catalog on page 214

� Approvals on page 215

� Phases on page 216

� Notifications and Alerts on page 218

� Closing a Quote on page 218

� Closing and Receiving Order Line Items on page 218

� Trickles/Bumps/Retiring on page 219

� Profile Definition on page 219

� Inventory/Reporting/Auditing on page 219

� Process Validation on page 220
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The Catalog

The Request Management application is based on the concept of a catalog. A 
catalog, or list of parts and services, is created containing all the items that a 
requestor might order. This would include request categories, master 
categories, and line items, such as a new phone, move/add/change of a PC, 
and a new logon ID.

The Catalog contains all the items that users can conceivably request, 
including request category packages, such as Employee Office Move or 
whether they directly request add something to their order at a later time. 

Catalog line items require detailed definitions, such as specific model 
numbers, prices, and delivery lead times. Other items that can be tracked 
include descriptions, vendors, and approval requirements. The Request 
Management system can only be as detailed as the Catalog entries. If it is 
necessary for cable drops, labor related items, training, etc., to be part of a 
quote, they must be defined to the Catalog.

A feature of the Catalog is the ability to group items in commonly ordered 
bundles. For example, a common desktop workstation might be identified as 
a 133MHz Pentium with a 2GB hard drive, 15" monitor, 8X CD-ROM, 16MB 
RAM, etc. The requestor could then just order a Standard Workstation rather 
than the individual components. On the other hand, you may also want to 
give the requestor the option of changing components or ordering just an 
individual component. This is true of services as well, such as. a New 
Employee Office request that may consist of a new phone connection, a LAN 
drop, a standard workstation, and a telephone.

Master Catalog Sections
Think of these as being the sections in the mail order catalog you receive at 
home, such as men’s clothing, women’s clothing, furniture, hardware, and 
kitchen items.

Within each master catalog section, the groups are further subdivided into 
line item categories.
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Structure of the Catalog

An entry in the catalog (such as High End PC) may be subdivided into 
further component entries (the bundles previously referenced). These entries 
are also items in the catalog. When an order is placed, the top-level item 
(considered a Parent item, and possibly a place-holder phantom item) is 
ordered. The requestor does not need to know any more about the line item 
than that. If the catalog item has been identified as being a bundle of lower 
level components, or Children items (also in the catalog), those items will 
automatically be broken out on the request. Each component then becomes 
a separate line item with its own costs and delivery dates.

The following table describes an example of a catalog entry.

When the customer requests a High End PC, all the underlying components 
are ordered and processed as line item entries.

Master Catalog Section Description Line Item Category

PC & Peripheral Personal Computers and 
Supplies

PC

PC parts

Pager Pagers pager

pager parts

Phone Office Phones and Accessories phone

phone parts

Security IDs and Sign-on Needs security

Relationship Part No Catalog Name

Parent 1 High End PC

Child 8 Pentium 200 MHz CPU, 
24 MB RAM

Child 12 17” Monitor

Child 25 Keyboard

Child 87 Mouse
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A customer may also order the 17" Monitor as a separate line item. Each 
entry is a catalog item in its own right.

Building the Catalog

To create the catalog, identify the parts and services that people request. If 
you wish to break the catalog entry down into further items, create an entry 
for each one and consider which part will serve as the Parent item of the 
individual components.

Vendors
The vendors may be either external suppliers or internal departments. Please 
fill in at least the first 7 items. You may have as many vendors as you need.

Required Information

Description of the entry

Catalog Line Item 

Model

Manufacturer

If this is a sub-component, what catalog item(s) is a parent?

Should this item generate an order?

Should this item create separate line items for quantity orders?

Are there any limits on the quantity that may be requested?

Who should approve this item?

If this is one of several sub-components of another Parent part, should the 
requestor be able to substitute a different item? 

How should this item be ordered? Batch or Immediate?

Is this item serialized?

Vendor Information

Catalog Description

Vendor Name

Vendor Part No.
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Approvals 

Approvals give controlling authorities (Approval groups) the responsibility 
of costs and risks associated with a request, the ability to stop work, and to 
control when certain work activities can proceed. 

� Which categories of catalog items require approvals? 

� Which catalog items require approvals? 

� What are the Approval groups?

� Who is in each group?

Transaction Type (purchase, lease, etc.)

Cost (in $)

Labor Hours

Labor Cost/Hour

Lead Time

Overtime Cost/Hour

Payment Frequency

No. Of Payments

Billing Code

Shipping Terms

Vendor Contract No.

Priority

Type of Order (purchase, lease, return, rental, work)

Warranty

Discounts

Vendor Information
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Phases 

Phases are administrative steps in the life cycle of a Quote. Typically, Request 
Management is configured for three phases: User Entry, Coordinator, and 
Ordering. The intent for these is: 

� User Entry. During this phase, the average user can access the Quote and 
change information on it, such as the client making the request, items 
requested, and requested delivery date.

Category Item
Require 

Approval?
Approval 
Group Name

Approval 
Group 
Members

PC Parts Pentium 200 MHz 
CPU, 24 MB RAM

Yes IT Supervisor Cathy Jones, 

Al Smith

Pentium 100 MHz, 
CPU, 16 MB RAM

No

17” Yes IT Supervisor Cathy Jones, 

Al Smith

15” Monitor No

Ergo Natural 
Keyboard

Yes IT Supervisor Cathy Jones, 

Al Smith

Win95 Keyboard No

Microsoft Mouse No

8X CD No

3 1/2” Floppy No

3COM NIC Card No

9600 bps Modem No

Microsoft Office 
Suite

No
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� Coordinator. During this phase, the coordinator can replace the user’s 
request for generic items with specific items and add detailed information 
to both the line item and the Quote. It is assumed that the coordinator will 
be responsible for gathering enough information to bill for the items and 
deliver them properly.

� Ordering. During this phase, items are passed to ordering, and the actual 
order is generated.

Some considerations for phase definitions include:

� Are these phase names acceptable?

� What requirements are there before closing a phase and opening the next?

� Should users who do not have update capability in a phase have browse 
capability at that phase?

� What is the administrative lead time at the Coordinator phase?

� How long does it take for the coordinator(s) to review a user’s request and 
process it into an order?

User Data Entry
Perhaps the requestor will be required to enter a minimal amount of data 
during the User Entry phase. For instance, the requestor would enter contact 
information, location, and type of request on a description form.

Coordinator Data Entry Fields
The request would then be routed to a coordinator who will contact the 
requestor for specific information. Think about these specifics when 
answering the following questions:

� What information do you need from the requestor for each catalog item 
you have previously identified?

� What fields must be validated in a certain format, and which must be 
validated to exist in a supplementary table? 

Some data items will be defined as coming from another table. A common 
example of this is contact information. 
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During the process of opening a Quote, the coordinator may be required to 
supply the first and last names of the individual requesting an item.

� Should this information be checked against the contacts table?

� What should be done if the individual is not yet in the contacts table?

Order Process
� How often will orders be generated?

� Will orders be combined to minimize paperwork given to vendors?

� What are the basic criteria to batch line items and create new Orders?

� How will Request Management interrelate with any external purchasing 
system already in use? If you use Get.It! Resources, you won’t need to 
order through Request Management, but access Get.It! Resources through 
the convenient button icons located within Request Management.

Notifications and Alerts

� What events will generate notification and alerts?

� For each event, who will be notified (typically the approver of something)?

� For each event, what manner of notification will be used (for example, 
pager, e-mail, or fax)?

� The alerts to be defined in the system?

Closing a Quote

� How will customer follow-up be handled?

� Will the operators doing follow-ups close the Quotes?

� What information needs to be collected at completion time?

Category Event
Notify: 
(approval group)

By: 
(pager, e-mail, etc.)

Pager Pending approval > 24 hrs. 

Not closed > 2 weeks

IT Supervisor

IT Supervisor

e-mail

e-mail
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Closing and Receiving Order Line Items

� Who will enter receipt information into Request Management when parts 
arrive at the receiving dock? Remember, if you use Get.It! Resources, you 
do not need to receive items into Request Management.

� How will Inventory be updated by this information?

� Will scripts be used when technicians close order line items for 
work/service/labor after their task is completed?

Trickles/Bumps/Retiring

� What is the inventory trickle process?

� Who determines where the old device goes?

Profile Definition

Generally, the standard user will have minimal direct access to Request 
Management. This user will have limited data views and limited options 
within the module. It is best to begin with a more restricted system and 
expand the options over time, rather than provide an open system and 
rescind permissions and accessibility to the product options at a later time.

Inventory/Reporting/Auditing

Inventory
� Are there plans for posting received inventory information into the 

inventory tables? 

� Is there a schedule in place for when this plan will be implemented?

Reporting
� Are there specific reporting requirements?

� Will the reports be scheduled or on demand reports? Will Request 
Management meet the reporting requirements defined in the customer’s 
design document?
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Auditing
� Which fields will be audited?

� Who will maintain the audit records?

� What are the reasons behind selecting to audit fields as opposed to 
tracking entire records via paging?

Process Validation

There is a need to validate the implementation of Request Management to 
your office’s expectations. Changes may be required in both the tool and the 
process to meet the your office goals. You need to determine what you want 
to accomplish and how Request Management will meet those requirements.

� Does your office’s process make sense in relation to the Request 
Management tool?

� Does Request Management make sense in relation to your office’s best 
practices and process?
220 �Appendix A—Pre-Implementation Planning 



APPENDIX

B
 Link Records
You can copy data from different data records to a line item via a standard 
link record. Request Management checks for the following link records for 
the indicated process

Note: The following are the Request Management link records which should 
be modified according to any renaming of Request Management files 
or forms.

Link Name From To When Used

ocml.copy.quote ocmq ocml When opening a line item 
from a quote

ocml.copy.order ocmo ocml When opening a line item 
from an order

ocml.copy.model model ocml When opening a line item 
from a catalog part

ocml.copy.modelvendor modelvendor ocml When opening a lien item 
from a catalog part and the 
user selected a vendor

ocml.receive.copy ocml ocmlrec When receiving process 
copies data from the line 
item to the receiving log
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If found, Request Management copies data from the source record to the line 
item based on the data fields defined at the detail level of the first element in 
the appropriate link record.

Do not use these link records for any other purposes. Request Management 
always uses the first element of the link record for copying data from the 
source record to the line item. It does not examine any other link elements.

For more information on how to use link records and the roles played by link 
records, see the ServiceCenter System Tailoring Guide.
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C
 Macros
There are no specific macros for Request Management. The standard macro 
options are available through the Macro Lister application. These can be set 
up to create actions from within Request Management. The standard options 
include:

� Fax 1 Assignment Group

� Fax 1 Person

� Fax Many People

� Mail 1 Assignment Group

� Mail 1 Person 

� Mail Many People

� Page 1 Person

� Page Many People

� Page an Assignment Group

To reach the Macro Lister:

1 Click Incident Management from the ServiceCenter home menu.

If you have administrative rights, the Security Files button is available on the 
Incident Management Menu tab.

2 Click Security Files.

3 Click ML (Macro List) from the Security Files tab on the Incident 
Management Security Administration Utility screen.
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4 From the Macro Lister screen that is displayed, click Add (+) to call the 
Macro Editor and define a macro for use in Request Management.

Click the down arrow to display a list of available macro types.

Figure C-1: Selecting A Macro Type

See the ServiceCenter Tailoring Guide for more information on macros, 
Macro Lister, and the Macro Editor.
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The following table describes frequently used terms.

Term Definition

Alerts A series of checkpoints taken against a Quote or Order to 
ensure that required work activities occur within specified 
time frames.

Approvals A list of groups that must acknowledge or accept the risk, 
cost, etc. associated with a specific Quote/Order and their 
associated Line Items. Approvals give controlling 
authorities the ability to stop work and to control when 
certain work activities can proceed.

Area A code that designates a level of processing or a record type. 
The codes are:

� Quotes—q
� Orders—o
� Line Items—l

Catalog (model file) File that contains the definitions that support the various 
parts and services which customers may order.

Categories The major logical classification of Quote/Order/Line Items.

Dependency Type The catalog creates dependency types by defining an item’s 
components and their grouped order. When a quote is 
created and items are grouped, then those items are ordered 
according to their dependency type within the group.

Event The occurrence of a specific detectable action or condition.
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Group One or more operators assigned to a common area of 
responsibility. Typically, each group reflects a business or 
technical area (or department). Certain operators are 
designated as having approval authority for these groups.

Grouped Similar items are grouped in the catalog under a common 
name. The primary grouping for catalog items.

Line Items A detailed record that defines part information such as cost, 
vendor, vendor part number, billing and shipping 
information, tax codes, and descriptions. Line Items are 
subordinate to Quotes and Orders.

Modelvendor A file that defines the vendor for each item in the catalog.

Order A high level record that defines the basic ordering 
information such as assignee, vendor, required dates, 
coordinator and description. An Order does not contain 
detailed part information.

Part A specific item that can be ordered by customers. It can 
have parent-child relationships with other parts.

Phase An administrative step in the cycle of a Quote or Order. 
Each category must have at least one phase defined in the 
category specification, and may have any number of phases 
defined (except Lien Item categories, which have only one 
defined Phase).

Profile The security record that defines which options are available 
for each Request Management operator or group.

Quote A high level record that defines the basic request 
information such as requestor, required dates, coordinator 
and description. A Quote does not contain detailed part 
information.

Receiving Log A file that tracks the date/time, operator, serial number and 
quantity for the receipt of physical items.

Vendor The entity who delivers the physical purchase items or 
performs the actual work/service items. Vendors can be 
internal or external to the organization.

Term Definition
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batch ordering
anticipated 178
demand 178
immediate 178
reorder type 107

C
capability words
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OCMLAdmin 30, 39
OCMO 30
OCMQ 30
SysAdmin 30, 39
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build 214
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data type 98
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overview 212
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catalog files
model 62, 91
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E
education services 12
environment record

environment.ocml 33
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line item 33
order 33
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manual orders
gen orders option 178
physical 178

master categories
adding 64
catalog 63
ocmcatselect 65, 68

messages
alerts 139
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model file
approval/alerts tab information

97
catalog file 62, 91
Catalog Information tab 110
catalog information, line item cate-

gory 109
component conditions informa-

tion 96
components tab information 93
current, quantities 105
dependencies information 94
description 90
General Information tab 104
model view 102
part conditions information 94
picture tab 111
quantities information 105
receiving/posting tab information

97
relationship with modelvendor file

112
reorder information 106
show all vendors 108
stockroom quantities information

105
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views 91

model record
user options 101
view options 99, 100, 101, 112

model view 102
modelvendor file

catalog files 62, 113
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ordering fields 116
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O
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ocmlcat 70
ocmlrec log file 191
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ocmoptions.q 77, 88
ocmprofile 37, 39
OCMQ 30
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options (cont.)
rebuild user profile 56
viewing a related record 27
viewing related records 26

ordering fields, modelvendor file 116
orders

application-rmo.create.check.avail
173, 176

application-rmo.create.order 173,
175

background ordering require-
ments 181

background processing 173
batch ordering 171, 178
default events 204
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180
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batch demand 178
batch immediate 178
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178
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overview 171
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line items
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locks 172
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